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1▼ ▼ ▼ ▼
Introduction
Thank you for purchasing Adaptec Toast 3.5, the world’s leading 
CD mastering software for the Macintosh. Toast is loaded with 
powerful features that will make your work easier. To get the most 
out of your new software, please take some time to review this 
manual. 

Toast lets you create CDs in many popular formats:

■ Mac Files & Folders, which lets you easily create an HFS CD 
containing any files or folders you choose.

■ Mac Volume, which is used to copy an entire volume or 
partition to a CD in HFS format.

■ ISO 9660, for making CDs which are compatible with a wide 
range of systems, including DOS, Windows, UNIX, Macintosh 
and more (now includes Joliet support for Windows 95 and 
WindowsNT.)

■ Mac/ISO Hybrid, combines the benefits HFS and ISO on a 
single disc. Toast even lets you define “shared” data to save 
disc space.

■ Audio CD for creating your own audio CDs that can be played 
in any standard CD player from existing CDs or from standard 
sound files.

■ CD-i for writing preauthored CD-i images to disc.

■ Enhanced Music CD (CD EXTRA) format that combines audio 
tracks and data.
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■ Video CD, creates CDs that can be played by Video CD or CD-i 
players.

■ SCSI Copy for making a direct copy of a hard drive or CD.

■ Disc Image format allows you to write previously created disc 
images to disc. (Such images can be created with Toast, or by 
other applications.)

■ Multitrack CD-ROM XA for writing existing XA tracks to disc.

■ Mixed Mode, combines data in HFS, ISO or any other format 
and audio tracks.

New in Version 3.5
Toast 3.5 adds several important new features based on user 
feedback:

■ Toast’s Greatest Hits - Allows you to easily create your own 
compilation audio discs by combining your favorite tracks 
from your CDs. Tracks can be copied directly from audio discs 
without having to save them on your hard drive.1

■ Audio Extraction- Save tracks from audio discs as standard 
AIFF sound files on your hard drive.2

■ Joliet support in ISO 9660 format. 

■ Support for rewriteable drives. 

1 Requires SCSI Manager 4.3
2 Requires SCSI Manager 4.3 and a CD-ROM drive that supports 
audio extraction
1-2
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Updates
Adaptec is committed to continuous improvement of all our 
products. We occasionally release updates to our software to 
incorporate support for new recorders and to correct any reported 
bugs. These updaters are available directly from our web site at 
http://www.adaptec.com

Registration
To qualify for technical support and to ensure that you receive 
notification of new versions, please mail the registration card that 
came with the software.

❒
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2▼ ▼ ▼ ▼
Installation
The Toast installation disc includes installers in several languages. 
Each installer is contained in its own folder. 

1 Insert the Toast disc in your CD-ROM drive.

2 Locate and open the appropriate language folder.

3 Double-click the Toast INSTALLER. 

4 Follow the on-screen instructions to install Toast on your hard 
drive.

Note: Toast is a “FAT” binary, so the same application runs 
on either Power Macintoshes or 68K Macintoshes.

About Toast CD Reader Extension

The Toast CD Reader extension is automatically installed in your 
Extensions folder. It allows you to use your CD recorder as a CD 
reader. Toast CD Reader is not required for writing CDs.
2-1
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Running the Software
Start Toast by double-clicking its icon.

The first time you run Toast, you must personalize the software.

After you have entered the personalization information, the main 
window appears.

The main functions of Toast are all easily accessible from the main 
window.

■ The upper part of the window shows information about the 
CD format and any data that you have selected. This 
information includes how much data is selected and the total 
running time for the selected data. 

■ The lower part of the window shows information related to 
your CD recorder, including SCSI ID and recorder brand and 
model.

❒
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3▼ ▼ ▼ ▼
Basics
About CDs
A CD (compact disc) is 1.2 mm thick and has a diameter of 8 or 12 
cm. Its data capacity is approximately 650 MB for 74-minutes discs 
and 550 MB for 63-minutes discs. The exact capacity varies from one 
brand of media to another.

The access time and data-transfer rate of a CD is typically much 
slower than a hard disk, although technological improvements have 
resulted in CD-ROM readers that read up to 8 times faster than the 
original single-speed drives.

The recordable part of a disc consists of (at least) three blocks:

■ Lead-In block: holds the directory information; located on the 
innermost 4 mm of the disc’s recording surface.

■ Program block: holds the data or audio tracks and fills the next 
33 mm of the disc.

■ Lead-Out block: marks the end of the CD and fills the external 
1 mm.

A CD is divided into sectors. The actual available size for data is 
2352 bytes for each sector. 

Different CD formats use that 2352 bytes in different ways. For 
example, an audio-CD uses all 2352 bytes for audio data, while data 
formats need several bytes for error detection and correction.

Each sector of a CD is again divided into logical blocks of 512, 1024 
or 2048 bytes. The block sizes are part of the definition for each CD 
format. 
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There are 5 different types of sectors:

■ Type 1 sectors are audio sectors; they contain only audio 
samples (1 Sample = 4 bytes).

■ Type 2 to 4 are data sectors used to store computer data 

■ Type 5 is a data sector used to store compressed audio and 
video data. 

■ Type 3 is very rarely used.

The standard recordable discs (12 cm diameter) can hold 63 or 74 
minutes of data. The capacity of a CD is measured in time 
(minutes:seconds:frames - 1 frame = 1 sector) rather than megabytes 
because CDs were originally conceived to store only audio data. 

The data for Audio CDs is 16 bit/44.1 kHz, stereo, that is, each audio 
sample occupies 4 bytes (16 bits = 2 bytes per channel), and one 
second of audio contains 44,100 samples. Because an audio sector 
(type 1; 2352 bytes/sector) contains only audio samples: 2352/4 = 

2352 Audio Sample Bytes

Sync
12

Header
4

Data
2048

Error correction
288

Sync
12

Header
4

Data
2336

Sync
12

Header
4

Subheader
8

Data
2048

EC
280

Sync
12

Header
4

Subheader
8

Data
2324

EC
4
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588 samples/sector. One second contains 75 sectors: 44.100/588 = 75 
sectors/second. Therefore a 74 min. CD-R contains 333,000 sectors 
(4,440 * 75).

The number of megabytes a CD can hold depends on on the type of 
sectors used on the disc:

■ If only type 1 sectors are used, these 333,000 sectors correspond 
to approximately 747 MB of audio data (333,000 * 2352 bytes).

■ If types 2 or 4 are used, they correspond to approximately 650 
MB of data (333,000*2048 bytes).

If a disc is read with a standard, single speed CD-ROM drive, 150 
kilobytes of data are read per second (75 sectors * 2048 bytes in one 
second). 
3-3
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Terminology
A list of commonly used terms and definitions follows.

AIFF

"Audio Interchange File Format,” created by Apple as a standard file 
format for saving sound files of any type.

Audio Sectors

Audio sectors are made up of the sound data you hear plus error 
correction data. Audio sectors cannot be read with a standard CD-
ROM drive. Many CD-ROM drives do, however, offer the ability to 
convert audio data to computer data. (see previous section “About 
CDs”).

Audio Tracks

Audio tracks are simply a collection of audio sectors. These tracks 
are playable on standard audio-CD-players. For the audio-CD 
players to be able to recognize and play the tracks, the tracks must 
always be in the FIRST session on the CD.

Blue Book

The Blue Book specifies the CD EXTRA standard for interactive 
CDs. A CD EXTRA (also known as Enhanced CD) is a multisession 
CD which contains audio tracks in its first session followed by a 
data track in the second session.

CD

A CD (Compact Disc) consists of up to approx. 333,000 sectors. 

CD Extra - see Enhanced Music CD
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CD-i

CD-i (Compact Disc Interactive) is a computer system developed by 
Philips. It is able to read discs in the following formats: CD-i, Video 
CD and Photo CD. A disc in CD-i format consists of one CD-i track 
with mode 2 sectors (types 4 and 5, see previous section “About 
CDs”). A CD-i is specified in the “Green Book”. Opposed to other 
CD-ROM XA discs, a CD-i track has no entry in the TOC.

CD-Recordable (CD-R)

CD recordables are special compact discs that can record data by 
using a special laser that “burns” microscopic holes in the recording 
layer. These pits can then be read by standard CD readers. 
Recordable CDs are somewhat more fragile than standard CDs, so 
care should be taken in their storage and handling. The label side is 
particularly delicate.

CD-ROM Tracks

CD-ROM tracks are made up of mode1 sectors (type 2, see previous 
section “About CDs”) and are used for many file systems such as 
HFS, ISO 9660, and others.

Disc-At-Once

Disc-at-once is a method of recording CDs whereby the entire CD is 
recorded in one pass without turning off the laser. The advantages of 
disc-at-once are twofold: 

■ No run-out sectors are generated, which means that the pause 
between each track can be made any length (songs can actually 
run together). 

■ If you are creating audio CDs to be commercially reproduced, 
it is normally necessary to record them in disc-at-once mode as 
run-out sectors will often be interpreted as irrecoverable 
errors. Not all CD-recorders can record in disc-at-once mode.

Disc Images

■ They contain all needed data to create a CD (as opposed to 
virtual images which contain only references to the data).

■ Most disc images can be mounted to check contents and 
functionality (Video CD disc images cannot be mounted). 
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■ Mounted disc images appear just like any other volume on the 
desktop. 

■ If the disc image was created from a Mac format ("Mac Files & 
Folders" or "Mac Volume"), the contents can be modified after 
mounting (all other disc images appear as write-protected 
volumes)

Enhanced Music CD / CD Extra 

CD Extra is the new standard for interactive albums defined in the 
Blue Book. These discs consist of two sessions. The first session 
consists of pure audio tracks, the second session consists of a data 
track in a restricted format. If a CD Extra is inserted into an audio 
CD player only the audio tracks are visible; the data session cannot 
be played.

Not all discs containing an audio session and an additional data 
session are CD Extras! The data tracks must contain special 
information such as MPEG still pictures, etc. Special software is 
needed to create a CD Extra file structure or a QuAC file.

Green Book

The Green Book describes the details of the CD-i format (Compact 
Disc Interactive).

HFS

Hierarchical File System. HFS is the standard Macintosh file system. 
Because of the Mac’s ability to use long file names and the unique 
data fork/resource fork structure of Mac files, HFS is not 
conformant to ISO Standard. On a CD recorded in HFS format, each 
session is represented as a separate volume on the desktop.

Both "Mac Files & Folders" and "Mac Volume" formats create CDs in 
the HFS format.

Index / Index-Point

Every sector contains an index which is a number between 0 and 99. 
Index 0 and 1 have special meanings: 0 indicates a pause sector and 
1 the beginning of the data in a track.
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ISO 9660

ISO 9660 format is a standard for cross-platform CD-ROMs. Discs 
created in this format can be read by many different operating 
systems, including Mac, Windows, DOS, UNIX, etc.

However, since ISO 9660 does not support long file names, custom 
icons or saved directory settings (that is, “view by Icon”), it is less 
than ideal for discs intended only for Macintosh users.

ISRC-Code

The ISRC-Code holds the "serial number" of each track in a 
standardized format (as prescribed by the Red Book). ISRC codes 
cannot be set in Toast, Adaptec Jam has to be used to define these 
codes.

Media Catalog Number

The Media Catalog Number (MCN) is a unique identification 
number for the CD (UPC/EAN Bar-Code). It is issued centrally by 
the EAN authority and consists of a series of 13 consecutive digits. 
The MCN can be defined only in Adaptec Jam.

Mixed Mode CD

A mixed mode CD consists of one data track and several audio 
tracks. Data and audio are written in one session. The data track is 
always placed before the audio tracks on the disc and this order 
cannot be changed.

The Mixed Mode format has generally been superseded by the 
audio/data Multisession format, where the first session consists of 
audio tracks and the second session consists of data (CD Extra or 
second session in HFS, ISO 9660 XA, Mac/ISO Hybrid XA format).

MPEG

MPEG is a standardized compression method for audio and video 
data. Because of its very high compression rates, MPEG makes it 
possible to play full screen/full motion video from a CD. MPEG 
tracks consist entirely of mode2 form2 sectors and are mostly found 
on Video CDs and CD-i discs.
3-7
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Multisession

A multisession CD consists of multiple sessions, each recorded at a 
different time. Each of the sessions are linked together in such a way 
that only one logical device appears when the CD is mounted. Not 
all CD-recorders can record this type of CD and not all CD-ROM 
drives can read them.

Multivolume

A multivolume CD consists of multiple sessions, each recorded at a 
different time. Each of the sessions are completely independent of 
one another so that when the CD is mounted, each 
session appears as an individual logical volume. Not all CD-
recorders can record this type of CD and not all CD-ROM drives can 
read them. NOTE: HFS CDs can only be multivolume, not 
multisession.

Orange Book

The Orange Book is the name of the standard developed by Sony 
and Philips for recordable CDs (CD-Rs). Part II of the Orange Book 
describes the structure of an empty CD-R and the recording 
procedure on a physical level.

Pause

A data CD recorded in track-at-once mode contains 150 sectors (2 
seconds) of pause and 2 run-out sectors between each track. 

On a mixed-mode CD (data + audio) written in track-at-once mode 
the gap equals 377 sectors: 375 of pause and 2 run-out sectors. 

A CD with multiple audio tracks written in track-at-once mode has 
gaps of 150 sectors pause and 2 run-out sectors. CDs recorded in 
disc-at-once mode do not have a fixed number of sectors between 
tracks.

Q-Codes

Q-Codes contain extra information about sectors such as the ISRC 
code, the Media Catalog Number, and the indices. 
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QuAC File

In 1995 Apple introduced the QuickTime Audio Containable 
standard for documents that contain information for music CDs as 
well as pictures and optional interactive controls. QuAC files can be 
created with the “Apple Interactive Music Toolkit™” (AIMT).

Red Book

The Red Book is the original CD-DA (Compact Disc Digital Audio) 
standard developed by Sony and Philips. The Red Book defines the 
format in which an audio CD must be recorded so that an audio CD-
player can play it. It also specifies what a CD-player must do to play 
audio CDs correctly. A CD recorded in accordance with the Red 
Book standard can be played in any CD-player.

Run-Out Sectors

Run-out sectors are created because the write laser beam cannot be 
turned off immediately upon termination of data recording. 
Consequently, 2 sectors are allocated to be “wasted” as the laser 
shuts down.

Scrambling

Data on a CD is scrambled (the bits of data are not recorded one 
after another in sequential order; the data is mixed up in a 
predefined pattern.) The recorder scrambles the data while writing 
and the CD player descrambles them when reading. 

Session

A session is a collection of one or more tracks. Each recording 
procedure generates a session that contains all the tracks recorded at 
that time. A CD recorded in multiple recording sessions is known as 
a multisession CD.

TOC

The TOC (table-of-contents) contains a list of the contents of a CD. 
The TOC contains an entry for each session and each track which 
lists the index 1 of each track (except CD-i tracks which have no 
entry in the TOC). The end or length of the track or session is not 
recorded in the TOC. 
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Track

The track is the smallest logical unit on a CD. A track is a minimum 
of 600 sectors in length and a CD can contain up to 99 tracks. There 
are three types of tracks: audio tracks, CD-ROM tracks and XA/CD-
i tracks. Each track must be preceded by 150 empty sectors. 

A CD recorded in disc-at-once mode requires only the 150 sectors 
before track 1.

Track-At-Once

The track-at-once mode records each track of a CD individually with 
150 empty sectors immediately preceding it. Run-out sectors are 
created at the end of each track.

Video CD

VIDEO CD format is used to record full-motion video or movies on 
a CD. Playing a Video CD requires special equipment, including an 
MPEG decoding system.

Use the Video CD format, if you want to write a “White Book” 
compatible Video CD that can be played on Video CD and CD-i 
players. A Video CD track must always be placed in the first session 
of a disc. 

White Book

The White Book describes the data format of a Video CD.

XA / CD-i Tracks

These tracks contain only mode2 sectors and are used for ISO 9660 
XA CDs, CD-is, Video CDs and Photo CDs.

Yellow Book

The Yellow Book is a document that specifies all parameters for CD-
ROMs. The adherence to these parameters guarantees that the CD 
can be used on all CD-ROM drives. The Yellow Book does not, 
however, specify the data structures.
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A Toaster’s Checklist
Here are some hints for making your CD mastering work as 
successful as possible:

■ Make sure your recorder is connected properly, using as short 
a cable as possible.

■ Verify that your SCSI chain is correctly terminated.

■ Keep the entire SCSI chain as short as possible. 

■ If you encounter speed problems, temporarily remove all 
unneeded SCSI devices (particularly scanners and SyQuest 
drives).

■ Disable all but essential extensions.

■ Check the data transfer rate before writing (see “Checking the 
Transfer Rate” on page 7-1)

■ Allocate most of your unused RAM to the RAM Cache (in 
Preferences from the Edit menu).

■ Before writing with a new system configuration or when 
writing in a format for the first time, write in Simulation Mode 
first.

The Optimal System Configuration
Several factors affect the hardware requirements for CD recording. 
In general, writing at higher speed (2x, 4x, 6x, etc) requires a faster 
computer and a faster hard drive.

We recommend using a Macintosh with 68040 processor or Power 
Mac with at least 16 MB of free RAM. (More RAM can help alleviate 
data transfer irregularities.)

Due to the limited SCSI performance of most PowerBook 
computers, they are not capable of writing CDs at high speed.

Several of Toast’s features require SCSI Manager 4.3. Macintoshes 
that support the SCSI Manager 4.3 are capable of significantly higher 
transfer rates.

You can see if your Macintosh supports SCSI Manager 4.3 by 
running Toast and looking at the way your recorder is identified in 
main window. If "Bus x ID y" is displayed, your Macintosh supports 
3-11
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SCSI Manager 4.3; if only the SCSI ID is displayed (no Bus), it does 
not.

Note: 68040 and PowerPC Macintoshes support SCSI 
Manager 4.3. Only newer PowerBooks like the 2400 and 
3400 support SCSI Manager 4.3.

Toast requires System 7.0 or above (we recommend using at least 
System 7.5).

The extensions "Drag & Drop Manager" and "Thread Manager" have 
to be installed when they are not part of the system (as in System 
7.5.x). If they are not installed, they are added automatically during 
the installation of Toast. The "Drag & Drop Manager" requires 
System 7.1. With System 7.0 you will not be able to drag any items 
onto the Toast window; data can only be selected using the dialog 
boxes.

Writing a CD
Writing a CD with Toast consists of four basic steps: 

1 Choose a CD format, 

2 Select the desired data, 

3 Verify that you have sufficient data transfer speed, 

4 Click the Write CD… button.

In many cases you can simply drag the data you want from the 
Finder onto the Toast window to select it. 

Toast offers many tools for refining your data selection, and for 
creating complex CDs in just a few simple steps. For more 
information, read the section on each format later in this manual.
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IMPORTANT NOTE
Writing CDs requires a significant amount of computing power. To 
maximize your success, we recommend turning off all but essential 
extensions and control panels when writing CDs. What is essential 
varies depending on your application, but generally you can run 
with ALL extensions off, except as noted below:

■ To copy directly from another CD-ROM drive, you will need to 
run the driver software for that CD-ROM drive (for example, 
an Apple CD-ROM drive uses two extensions: APPLE CD-
ROM and FOREIGN FILE ACCESS).

■ To copy from a network volume, you will need the networking 
drivers. These may include APPLESHARE, OPEN 
TRANSPORT, NETWORK, APPLETALK, TCP/IP, among 
others.

In addition, to maximize your data transfer rates, you may want to 
disconnect any extra SCSI devices. SyQuest drives and scanners in 
particular have been known to slow down the SCSI chain (see 
“What to do if “Check Speed” fails” on page 7-4).

❒
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Supported Formats
Mac Volume
The Mac Volume format is used to write the entire contents of a local 
volume or partition to the CD in HFS format.

Areas of Application
Use Mac Volume : 

■ To copy an entire volume (hard disk, partition, cartridge, etc. ) 
to a disc exactly as it is.

■ To precisely control the visual appearance of the disc. 

■ To publish a disc.

■ To create a bootable CD 

■ To define a file on the disc that is to be opened automatically 
when the disc is inserted.

■ To optimize the data for faster access. 

For detailed information on this format as well as its settings see 
“Mac Volume Format” on page 6-1. 

Writing a Disc
To write a disc in the Mac Volume format

1 Prepare your source volume exactly as it should appear on the 
disc. 
4-1
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Since an identical copy of your source volume is created, icons, 
position and order of windows and objects, etc. are faithfully 
copied from the source volume to the disc. 

If you don’t have a hard disk volume or partition that contains 
only the data for the CD, you can use Toast to create a 
Temporary Partition to hold the data (see “Create Temporary 
Partition” on page 5-10).

2 Choose Mac Volume from the Format menu and click Data….

The following window is displayed:

3 Highlight the desired volume in the upper part of the dialog 
box. 

You can only select volumes with the comment “ok to write”. 
Depending on the settings you choose, the comments might 
change. 

4 Select any additional features using the checkboxes:

– Optimize on-the-fly to have Toast automatically 
defragment your data. 

– Don’t copy free space, if you are not optimizing. 

For detailed information on the various settings see “Mac 
Volume Format” on page 6-1.

5 Click OK.
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The amount of the selected data and the associated settings is 
displayed on the main window:

6 Choose Check Aliases from the Utilities menu.

Select the desired volume and click OK (see “The Utilities 
Menu” on page 5-9).

7 Click Check Speed….

Toast reads all the selected data to determine if your system is 
fast enough to write the disc in the chosen speed.

When the test is completed, click Done. 

For more information on the data rate see “What is Transfer 
Rate?” on page 7-1. 

8 Insert a recordable CD in your writer. This disc may be either 
empty or contain data that has been written as a session.

To determine if the inserted disc is still recordable, you can 
choose Disc Info from the Recorder menu . 

9 Click Write CD….

The following dialog will be displayed:

10 Verify that the desired writing speed is selected in the pop-up 
menu.
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11 If you may want to add data to this disc later, click Write 
Session. (If your source volume contains more than 625 MB 
this option is disabled. ) 

If you want the disc to be closed so that no further data can be 
added later, click Write Disc.

The writing process will begin at the selected speed. When all 
the data is written, Toast will automatically verify the data.

 

For additional information on this format see “Mac Volume Format” 
on page 6-1.
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Example: Creating a Disc for Publication

Your Situation and Your Goal:

You want to write a pure Macintosh HFS disc, ready to be 
duplicated at a disc manufacturing plant. 

■ The data includes numerous small files and many customized 
icons. 

■ You have a hard disk at your disposal that contains only the 
data that is to be written. 

■ You want the disc to hold as much data as possible. 

■ Your clients’ convenience when using the disc is of highest 
importance to you. 

Procedure:

1 Prepare the data to be written exactly as you want it to appear 
on the disc. Since the appearance of each window is important, 
open each folder and arrange the files in your preferred layout. 
(Remember, the disc will keep everything just as you left it, 
including view, label settings, and icon positions).

2 Open Toast and choose Mac Volume from the Format menu. 

3 Click Data…:

4 Because you are using customized icons for many items and 
there are many smaller files on your hard disk, it is very 
important to optimize the data. 

5 Check the option Optimize for Size. 

This ensures that the icons are displayed rapidly after 
mounting and that you make the most efficient use of the space 
on your disc. Leave the other options unchecked.
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6 Click OK, load the data. 

A figure for the entire amount of data is displayed on the main 
window, which corresponds to the figure that is displayed as 
Used in the Info dialog box. This figure might be bigger than 
the free space on your CD-recordable. 

However, since you have selected Optimize for Size and your 
data includes many small files, this figure will most probably 
be reduced during optimization.

7 To make sure all aliases point to target files that are placed on 
the same volume, choose Check Aliases from the Utilities 
menu.

Select your hard disk to have it checked.

8 To make sure that the selected amount of data will fit onto your 
disc after optimizing, click Check Speed….

Before the data rate is actually checked, the data is prepared for 
optimization:

Note: Once the checking of the data rate has begun, you can 
cancel the process, because you are just checking the 
amount of data after optimization. 

9 Click Done to cancel. 

The main window now indicates how much space your data 
will actually use on the CD. If it is still too large for your disc, 
you must delete files from your hard disk and repeat the 
procedure.

10 Check the data rate before writing and write the disc. 
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Mac Files & Folders
Mac Files & Folders is a variation of the HFS format which allows 
you to select any combination of files, folders and volumes as the 
source for your data. It is even possible to select items from network 
volumes (depends on network bandwidth).

Areas of Application
Choose Mac Files & Folders format: 

■ For easy backups

■ For rapid data archiving

■ To write open files, for example, the currently used system files 
on your startup volume

■ To control the treatment of aliases. Mac Files & Folders allows 
you to determine for each alias whether the alias itself or the 
target file will be written to the CD. 

To prepare a disc for publishing purposes, we strongly recommend 
using the format Mac Volume, since Mac Files & Folders gives you 
only limited control over the layout of your disc.

Writing a Disc
To use the Mac Files & Folders format:

1 Start Toast and choose Mac Files & Folders from the Format 
menu. 

2 Click Data….
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The following window is displayed.

3 Either click Add… and select the desired items:

Click Add until all items are selected. Then click Done.

Or

Drag files and folders that you want to be written to the disc 
from the Finder onto the window. (You do not have to select 
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everything at once. Drag as many times as necessary to include 
all the desired files.)

Depending on what you drag into the empty window, your 
results will be different:

4 After selecting all your data, click Done. 

If you drag . . . Then . . .

One folder This folder is made into a disc.
Name of the folder = Name of the disc
Icon of the folder - Icon of the disc
Contents of the folder = Contents of the disc

One folder 
while the 
control button 
is pressed

A new untitled disc is created, the folder is 
placed on the top level in the folder 
hierarchy

Several folders A new untitled disc is created; all folders are 
placed on the top level in the folder 
hierarchy

One or several 
files

A new untitled disc is created, all files are 
placed on the top level in the folder 
hierarchy

Folders and 
files

A new untitled disc is created; all objects are 
placed on the top level in the folder 
hierarchy
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The size of the selected data will be displayed in the main 
window:

Note: Toast allows you to save your setup so you can use it 
later. Simply choose the Save As command from the File 
menu.

5 Click Check Speed….

Toast reads all the selected data to determine if your system is 
fast enough to write the disc in the chosen speed.

6 When the test is completed, click Done. 

7 Insert a recordable CD in your writer. This disc may be empty 
or may contain data that has been written as a session.

To determine if the inserted disc is still recordable, choose Disc 
Info from the Recorder menu. 

8 Click Write CD…. The following dialog box is displayed:

9 Verify that the desired writing speed is selected in the pop-up 
menu.

10 If you may want to add data to this disc later, click Write 
Session. (If your source volume contains more than 625 MB 
this option is disabled. ) 
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To close the disc so that no further data can be added later, 
click Write Disc.

The writing process begins at the selected speed. When all the 
data is written, Toast automatically verifies the data.

For additional information on this format see “Mac Files & Folders 
Format” on page 6-8.
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Example 1: Backup with Aliases

Your Situation and Your Goal:

You want to create a backup of your clients’ data. To make your 
work easier, you have created several aliases. This is the folder that 
is to be backed up:

The folders “John” and “Francis” should be copied exactly as they 
appear originally. The folder “Clark” contains aliases that should be 
loaded in different ways.

– The alias “January” points to another hard disk, that 
contains already completed projects. In this case the original 
should be written instead of the alias.

– The folder “February” should be copied exactly as it is.

– The folder “March” contains references to target files that are 
located in the folder “February”. So those files are not 
written twice, they should be written as aliases to the disc.

Procedure:

1 Choose Mac Files & Folders from the Format menu and click 
Data…. 

The empty selection window is displayed. 

2 Click New CD to create an empty disc for your backup. 
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3 Change the name of the disc to “Backup.” Double-click the disc 
icon to open the information window where you can specify 
the new name.

4 Click New Folder. Name this folder “Clients A-K.” 

(Note: If all aliases were treated alike, you could drag the 
original folder “Clients A-K” onto the selection window.)

5 Drag the two folders “John” and “Francis” over the folder 
“Clients A-K” you have just created, since those folders are to 
be written to the disc without any changes. Since these folders 
do not contain any aliases, you need not choose any other 
settings.

6 Click New Folder. Name this folder “Clark”. 

Drag this folder over the folder “Clients A-K” in order to place 
it on the same level in the folder hierarchy as “John” and 
“Francis”.

7 Check the option Resolve Aliases and drag the alias “January” 
over the folder “Clark”.

Instead of the alias the original data will now be loaded from 
the second hard disk.

8 Uncheck the option Resolve Aliases (the box next to it is not 
xed) and drag the two folders “February” and “March” over 
the folder “Clark”.

If you look at the contents of the folder “March” (to do this, 
click on the small arrow icon so that it points to the bottom), 
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you will see from the italics, that the two aliases “Picture DEF” 
and “Picture XYZ” were loaded instead of the original files.

9 Load all further data for your backup, click Done, check the 
data rate and write the disc.

Example 2: Folders with Customized Icons

Your Situation and Your Goal:

You want to create the same backup as in example 1, but you prefer 
icons other than the standard icons, both for the disc and the folder 
“Clients A-K”. However, you cannot change any icons in Toast itself. 

Procedure:

1 If you create an empty disk as in example 1, you will not have 
an opportunity to change the icon later. Therefore, you must 
change the icons on the Finder level.

2 Create a new folder on a hard disk and name it “Backup”. 

3 Copy the icon of your choice for the disc from a suitable 
source. 

4 Highlight the newly created folder and choose Get Info... from 
the File menu of the Finder.
4-14



Supported Formats
5 Highlight the icon displayed there by clicking with the mouse 
and insert the icon by choosing Paste from the Edit menu of 
the Finder.

6 Repeat steps 1) - 4) for the folder “Clients A-K”. 

7 Choose Mac Files & Folders from the Format menu in Toast 
and click Data….

8 Drag the empty folder “Backup” that contains the icon of your 
choice onto the selection window. The folder will be made into 
the disc. The icon is displayed in this folder as an invisible file 
(displayed as a “grayed” icon).

9 Now drag the folder “Clients A-K” onto the disc icon, so that it 
is placed in the top level of the folder hierarchy. 

10 Now continue to import your data as described in example 1.
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Example 3: Backup over a Network

Your Situation and Your Goal:

You want to create a backup from various computers in the network. 
To do so you choose a time of day when the network will not be 
busy. 

Note: Not all networks are fast enough to support direct 
writing to CD. Be sure to check the speed before trying to 
write from the network.

Procedure:

1 Choose Mac Files & Folders from the Format menu and click 
Data…. 

2 Click New CD and name the disc, for example, “Backup Jan 20, 
96”. 

3 Now mount all the volumes that contain the data to be backed 
up.

4 Drag the data that is to be written into the selection window in 
Toast. 

5 When you have selected all the data, click Done. 

Note:  Since the data has not been loaded from locally 
mounted volumes, Toast will use the desktop files of your 
startup volume for the disc. 

6 Check the speed for all the selected data. To do this click Check 
Speed….

Go through the entire checking routine! When the selected 
data is not located on local volumes, the data rate is extremely 
important. In case of an insufficient data rate you could create 
a disc image before writing (for details on possible problems 
and solutions see “What to do if “Check Speed” fails” on page 
7-4.) 

7 Write the disc.
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ISO 9660
The ISO 9660 format is a standard for cross-platform CD-ROMs. 
Discs created in this format can be read by many different operating 
systems, including Mac, DOS, UNIX, etc.

Toast can create standard ISO discs, as well as ISOdiscs with Joliet 
extensions which preserve the long file name structures from 
Windows95 and WindowsNT. 

Since ISO 9660 does not support custom icons or saved directory 
settings (i.e. “view by Icon”), it is less than ideal for discs intended 
only for Macintosh users.

Note: Toast also supports a special ISO option which 
preserves Macintosh file names. Discs written using this 
option are only useable on Macintosh computers.

Areas of Application
“ISO 9660” format should be used when:

■ You want to write a disc that can be run on several platforms, 
for example, Windows, Windows 95, UNIX, Atari, Amiga, 
Macintosh, etc. 

■ You want to write multisession CDs where all sessions are 
mounted as a single volume (in contrast to HFS Multivolume 
where each session appears as a separate volume).

■ You prefer incremental backups for your backup purposes, 
that is, only the data that has changed since the last session is 
written to the disc. Unchanged data is never written to the disc 
more than once, saving space and time.

For detailed information on this format as well as its settings see 
“ISO 9660 Format” on page 6-15.
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Writing the First ISO Session
To write the first or only session of an ISO 9660 disc, proceed as 
described below:

1 Choose ISO 9660 from the Format menu. 

2 Click Data….

The following window is displayed:

3 Either click Add…:

Click Add until all the desired data is selected. Then click 
Done.

Or 
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Drag files and folders that you want to be written to the disc 
from the Finder onto this window.

Depending on what you drag onto the empty window, your 
results will be different:

4 Click the Settings tab at the top edge of the window.

If you drag . . . Result

One Folder The folder is made into a disc.
Name of the folder = Name of the disc
Icon of the folder = Icon of the disc

One folder while the 
control button is 
pressed

A new untitled disc is created; the folder is 
placed on the top level in the folder 
hierarchy

Several folders A new untitled disc is created; all folders are 
placed on the top level in the folder 
hierarchy

One or several files A new untitled disc is created; all files are 
placed on the top level in the folder 
hierarchy

Folders and files A new untitled disc is created; all objects are 
placed on the top level in the folder 
hierarchy
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The following window appears:

5 Select a data format from the Format menu: 

– Choose the format CD-ROM XA, if you want to be able to 
add more sessions to this disc later.

– Choose the format CD-ROM, if you do not intend to add 
more data to the disc later.

6 Choose a Naming option for your files and folders. Toast 
automatically converts file names to conform to the naming 
option selected.

7 Click Done.

The number of files and folders, the size of the selected data, 
and the space they will occupy on the disc will be displayed in 
the main window:

Note: Toast allows you to save your setup so you can use it 
later. Simply choose the Save as command from the File 
menu. 

8 Click Check Speed….
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Toast reads all the selected data to determine if your system is 
fast enough to write the disc in the chosen speed.

When the test is completed, click Done. 

9 Insert a recordable CD in your writer. This disc may be either 
empty or contain data that has been previously written as a 
session.

To determine if the inserted disc is still recordable, you can 
choose Disc Info from the Recorder menu . 

10 Click Write CD….

The following dialog box is displayed:

11 Verify that the desired writing speed is selected in the pop-up 
menu.

12 If you may want to add data to this disc later, click Write 
Session. (If your source volume contains more than 625 MB 
this option is disabled.) 

13 If you want the disc to be closed so that no further data can be 
added later, click Write Disc.

The writing process begins at the selected speed. When all the 
data is written, Toast automatically verifies the data.

For additional information on this format see “ISO 9660 Format” on 
page 6-15.
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Writing an Additional ISO Session
This section covers the procedure for adding an additional ISO 
session to a disc containing one or more ISO sessions. 

For detailed information on this format as well as its settings see 
“ISO 9660 – Multisession Format” on page 6-27. 

If you add a new session to the disc and want to make sure that the 
data from the previous sessions is still accessible, follow these steps:

1 Choose ISO 9660 from the Format menu and click Data…. 

2 Drag the data of your choice onto the window. 

For details on the data selection see the previous section, 
“Writing the First ISO Session”.

3 Click the Settings tab.

Make sure that the format CD-ROM XA is selected and that 
you select the same naming option that you used in the 
previous session.

For information on importing previous sessions from a disc see 
“Importing a Session from a Disc” on page 6-29. 

4 Click Done.

The size of the selected data will be displayed in the main 
window. 

5 Click Check Speed….

6 When the Data rate has been checked, click Done. 

7 Insert the ISO disc to which you want to add the data into your 
CD recorder. 

To verify that the inserted disc is really the disc to which you 
want to add the data, you can choose Disc Info from the 
Recorder menu.

8 Click Write CD….
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The following dialog box is displayed:

9 Choose Ignore Existing Sessions, if you do not want 
previously written sessions visible when inserting the disc. (it 
will be as if the data from the old sessions was deleted from the 
disc.)

10 Choose Append to [Name of last session], to make all sessions 
visible when you insert the disc.

11 Click OK.

The following dialog box is displayed:

12 Click Write Session, if you want to add data to this disc later. 

13 Click Write Disc, if you want the disc to be closed so that no 
further data can be added later.

Note: If the setting CD-ROM was chosen for the previous 
session, you will be unable to add a new session to the disc!

The writing process will begin at the selected speed. When it is 
completed, the data will be verified automatically. 
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For additional information on this format see “ISO 9660 – 
Multisession Format” on page 6-27.

Example 1: Daily Backups of a Current Project

Your Situation and Your Goal:

Your are working on a project for client “Smith” and you would like 
to backup your work daily. The project is placed in a folder that has 
the following structure:

You never change the basic structure of this folder. You only add 
data, or change or delete existing data.

Since many files do not change every day, you want only new data 
to be written to the disc to save space and time.

You only want the most recent version of the files to be visible on the 
disc.

Procedure:

You begin by backing up all the data to a blank disc, then adding the 
changed data to the same disc when you backup again.

1 Choose ISO 9600 from the Format menu and click Data…. 

The empty selection window will be displayed. 

2 Drag the folder “Smith” onto the selection window. A new disc 
is created with the folder name “Smith” as its name.
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As an example, we will now look at the subfolder “Pictures” of 
the folder “Ads”:

This folder contains three pictures “Car boot”, 
“Car driver’s side” and “Logo”.

3 Click Settings.

– Choose CD-ROM XA as format

– Allow Macintosh Names as naming option. 

– Also check Use Apple Extensions. 

Note: You can click Set Defaults… to save these settings so 
you won’t have to reselect them each time you backup.

4 Click Done.

The size of the selected data will be displayed in the main 
window. 

5 Click Check Speed… to check the transfer rate. 

6 Click Write CD… and then Write Session. 

All the selected data will be written to the disc. 

When finished, the data in our example would look something 
like this:
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When you are ready to back-up the changed data. 

1 Again, choose ISO 9660 and click Data….

2 Drag the same folder “Smith” onto the selection window. 
These are the differences:

The file “Logo” was deleted, the file “Logo new” was added. 

The picture “Car front side” was added. 

3 Verify that you have selected CD-ROM XA as format, 
Macintosh Names as naming option and that Apple Extensions 
are activated, then click Done.

4 Click Write CD….

The following dialog box is displayed:

5 Check the option Incremental Backup and click OK . 

Toast now checks which files were changed, deleted, or added. 
After checking, only the size of the data that is actually to be 
written is displayed in MB in the main window. 

6 Click Write Session in the next dialog box. 

Only the changed data will be written to the disc. 
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After writing, the folder “Pictures” will look like this:

The picture “Logo” is not visible any more, because it was 
deleted from the source folder.

Note: if any files have exactly the same name and the same 
modification date and are placed in the same file structure 
as in the previous session, they will not be written to the 
disc again.

Example 2: Specific Rearrangement of Old Sessions 

Your Situation and Your Goal:

At the conclusion of your project “Smith” (as described above), you 
obtain a hard disk from your client that contains further data. You 
want to write this data to your disc without saving it on your hard 
disk first. Your client’s hard disk contains a folder with new pictures. 
You want to arrange these pictures on the disc so that they appear in 
the appropriate existing folders.

As an example, we will again look at the subfolder “Pictures” of the 
folder “Ads”.

Procedure:

1 Start Toast and insert the disc with the project “Smith” in the 
recorder. 

2 Choose ISO 9660 from the Format menu and click Data…. 

The empty selection window will be displayed. 
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3 Select Import Session… from the pop-up menu in the window.

Toast will read all sessions of the inserted disc and display 
them in a window:

4 Highlight the last session (it contains the newest data), select 
Merged and click OK . 

The entire file structure of the imported session will now be 
displayed in the selection window:

The files that are marked with a disc icon have already been 
written to the disc (all files in this case).

5 Click New Folder.

A new folder is created on the top level in the folder hierarchy. 

6 Double-click the new folder.
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The following window is displayed:

7 Name the folder “Originals” and click OK.

8 Drag the new folder over the subfolder “Pictures” of the folder 
“Ads”.

9 Now drag all the pictures you want from you client’s hard disk 
over the folder “Originals” and click Done (this example 
assumes that you have already defined the correct settings for 
format and naming option as default in example 1).

10 Check the transfer rate and click Write CD. 

11 Click Write Disc in the dialog now displayed, because the 
project is to be concluded with this session.

Toast will write only the new data that you have selected. The 
file structure and the data of the last imported session will be 
retained. 
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After writing, the disc looks like this:

Example 3:Placing old Sessions in a Folder 

Your Situation and Your Goal:

You are beginning a new project for your client Smith. You want to 
keep all the files from the old project, but you want them marked as 
“old projects”.

Procedure:

1 Start Toast and insert the disc with the old projects in your 
recorder. 

2 Choose ISO 9660 from the Format menu and click Data…. 

3 Click New CD and name it “Smith projects”. 

4 Drag the files and folders from the new project onto the 
window. 

They will appear at the top level of the folder hierarchy.

5 Choose Import Session from the pop-up menu in the window.
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Toast reads and displays the contents of the disc. 

6 Highlight the last session (it contains all the data) and choose 
the option Put into a directory. Click OK.

The previous session appears as a folder on the top level in the 
folder hierarchy.

7 Change the name of the folder that contains the old session to 
“Smith old” and click Done.

8 Check the data transfer rate and write the disc.

This part was newly loaded.

This part has already been 
written to the disc.
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When finished, the disc looks something like this:

The folder “Smith old” contains the data from previous 
sessions, while the folder “Mailing February” contains the new 
project.

Mac/ISO Hybrid
The HYBRID format combines both ISO 9660 and HFS format on a 
single disc. This allows Macintosh users to see the normal icons and 
window positions for the data, while maintaining complete 
compatibility with DOS/Windows systems (and others).

Areas of Application
HYBRID format should be used when:

You want to write discs that can be read on a Macintosh and on a 
PC, with the Macintosh data visible only to Macintosh users and the 
ISO data visible only to other users.

Hybrid format is ideal for: 

– Multimedia applications intended for both Macintosh and 
DOS/Windows.

– Writing picture, sound, or text files that can be read on both 
platforms.

– Software created for both platforms that you want to deliver 
on a single disc.

– As the second session of an audio CD, so that the audio 
tracks are only shown on an Audio CD player and the 
computer data only on a computer (many people mistake 
this for CD Extra). 
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For detailed information on this format as well as its settings see 
“Mac/ISO Hybrid Format” on page 6-32.

Writing the Disc
A disc can contain only one Hybrid session. This session can be 
written as a first session or as the second session of an audio CD. 

A Mac/ISO Hybrid disc uses two data sources: a Macintosh volume 
and a group of files/folders that are selected to be the ISO data.

1 Preparing the Data for the Macintosh Part of the Disc 

The Macintosh part of the Hybrid disc must be created from a 
Macintosh volume (hard disk, temporary partition, hard 
partition, etc.).

This volume should contain:

– Files and folders that will only be visible on the Macintosh 
and

– Files and folders that will be visible to both the Macintosh 
and ISO users. This is referred to as the “shared data” (these 
files will be written to the disc only once). 

Note: The Macintosh volume will be copied exactly to the 
disc, including window sizes, positions and view settings. If 
the arrangement of the windows is important to you, be 
sure to prepare the volume accordingly. 

2 Preparing the Data for the ISO Part of the Disc 

Generally, no special preparation is needed for the ISO part, 
since you can choose files and folders one by one for writing. 
However, if you intend to prepare the disc for publishing, we 
recommend you collect the ISO data in a folder. This will help 
you to avoid mistakes and also makes the data selection easier. 
The determination of which data is shared occurs while 
selecting the ISO data (see below). 

3 Selecting the Macintosh Data

To select the Macintosh data for the Hybrid disc: 

a Choose Mac/ISO Hybrid from the Format menu.
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b Click Mac….

The following window is displayed:

c Highlight the volume of your choice in the upper part of the 
window. 

Check Optimize to avoid problems relating to sector sizes 
and to make the disc as responsive as possible. Click OK. 

The size of the selected data is displayed in the main 
window.

For detailed information on this format as well as its 
settings see “Mac Volume Format” on page 6-1.

4 Selecting the exclusive ISO Data

To select the exclusive ISO data for the Hybrid disc: 

a Click ISO….
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An empty selection window is displayed:

b Drag the ISO data onto the selection window or click 
Add…. 

Any files that are not placed on the selected Macintosh 
volume will be displayed in black print.

5 Selecting the Shared Data

a Now drag any shared data from the Macintosh volume 
selected in step “C” to the desired location in the ISO file 
structure or click Add… to select them. 

Files and folders may have different names in the Mac and 
in the ISO part.

Shared files are displayed in blue (only the files, not the 
folders). These files will be written to the disc only once but 
will be visible by both Mac and PCusers.

6 Settings
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a Click the Settings tab. The following window is displayed:

– Choose the format CD-ROM XA, if the Hybrid session will 
be the second session of an audio CD.

– Choose CD-ROM, if this is to be the only session on the disc.

b Choose a Naming option for files and folders. 

7 Writing a Disc

a When you have selected all the data and chosen the correct 
settings, click Done.

The selected data is displayed in the main window:

Note: Toast allows you to save your setup so you can use it 
later. Simply choose the Save as command from the File 
menu.

b Click Check Speed….

Toast reads all the selected data to determine if your system 
is fast enough to write the disc in the chosen speed.

When the test is completed, click Done. 
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c Insert a recordable CD in your writer.

d Click Write CD….

The following dialog box is displayed:

e Verify that the desired writing speed is selected in the pop-
up menu.

f Click Write Disc (writing a session is not recommended for 
Hybrid discs).

The writing process begins at the selected speed. 

When all the data is written, Toast automatically verifies the 
data.

For additional information on this format see “Mac/ISO Hybrid 
Format” on page 6-32; also see “ISO 9660 Format” on page 6-15.
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Example 1: Creating a Disc for Publication 

Your Situation and Your Goal:

You want to write a Hybrid disc that will be submitted for 
manufacturing. You have created a multimedia application that has 
different applications (executables) for Macintosh and PC but that 
uses the same supporting data files.

For the Macintosh part you have a hard disk at your disposal that 
contains all the Macintosh data together with the shared data. You 
have arranged the hard disk so that the main window is open and 
only the executable application is visible:

For the ISO part you have created a folder on another hard disk, 
that contains data that will be visible only to PC users:

Note: It is no longer necessary to create aliases for shared 
data (as required in older versions of Toast); however, this 
method will still work. Toast realizes if an alias points to a 
target file on the selected Macintosh volume and will write 
this file only once (if Resolve aliases is checked).

With some authoring applications it may cause problems if you use 
different names for shared data on the Macintosh and PC sides. We 
recommend that you use names of the format 8.3 characters for all 
shared files. (Check with the publisher of your authoring applications for 
information on handling shared data files.)

The multimedia application for the 
Macintosh on a Macintosh 
volume.

The data for the PC

The folder “DOS” is empty at the 
moment, it will later contain the 
shared data.
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For details on restrictions for the naming options see “ISO 9660 
Format” on page 6-15.

Procedure:

1 Choose Mac/ISO Hybrid from the Format menu. 

2 Click Mac….

3 Highlight the hard disk that contains the Macintosh data and 
the shared data. Since you intend to publish the disc, you want 
the data arrangement on the disc to be as perfect as possible. 
Therefore, check the option Optimize. Do not check the other 
options. Click OK.

If your system configuration is not fast enough to optimize on-
the-fly, you can save a disc image of all the data before writing 
(see below). 

4 Click ISO….

The empty selection window is displayed. 

5 Drag the folder containing the ISO data onto the window. 

All these files belong exclusively to the ISO part, so all file 
names are displayed in black:
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6 In the Finder highlight the files on the selected Macintosh 
volume that are to be shared by the Macintosh and ISO parts of 
the disc.

7 Drag these files onto the folder “DOS” in the ISO window. 

The shared files are displayed in blue:

All files in the folder “DOS” are shared, since they have 
already been selected as part of the Mac volume.

8 Click Settings and choose the following options: 

– Format: CD-ROM

– Naming: Allow MS-DOS Names

– Append Version numbers: not checked

– Use Apple extensions: not checked

9 Click OK.
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The size of the selected data will be displayed in the main 
window:

10 Click Check Speed….

Before the checking routine begins, the optimization process 
will be prepared:

After this, the speed check routine will start. Be sure to allow 
the check to finish if you are unsure whether your system is 
fast enough to optimize on-the-fly. Click Done. 

11 Click Write CD….

If the result of the speed check was negative, check the option 
Create Disc Image First and click OK. (If a disc image is 
created, you will be asked to specify a location for storing the 
image file). 

The writing process starts automatically after saving.
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Example 2: Creating a Disc that Only Contains Shared Data 

Your Situation and Your Goal:

You want to create a disc that contains graphics and text files. Since 
you do not know whether the disc will be used on a Mac or a PC, 
you decide to write a Hybrid disc. (You could also use the pure ISO 
9660 format, but it does not allow control over the placement and 
appearance of files as HFS does.)

You have collected all the data in a folder, rather than having it on a 
volume which contains no other data. Consequently, you create a 
temporary partition for the Macintosh part and copy the data into it.

Procedure:

1 Creating a Temporary Partition

a Make sure that you have a hard disk connected with enough 
free space to duplicate all the data to be written. 

b Choose Create Temporary Partition from the Utilities menu.

The following window will be displayed:

c Enter a size for the partition that is about 2 MB larger than 
the data to be copied. (You can use the GET INFO command 
in the Finder to determine the size of the data.)

Select a volume that contains sufficient free space and click 
OK. 

The temporary partition will be created. A single file (the 
“image file”) the size of the partition will be created on the 
volume you selected; the partition itself will be mounted on 
the desktop. 
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For details on temporary partitions see “Create Temporary 
Partition” on page 5-10 

d Copy the contents of your folder into the mounted partition 
by dragging it onto the icon of the mounted partition (not 
the icon of the image file). 

Arrange the data as you would like it to appear on the 
finished disc:

Note: If you have chosen a custom font for displaying file 
names (using the VIEWS control panel), it is a good idea to 
reset the font to the default setting of “9 pt Geneva” before 
arranging the icons. This will help ensure that the windows 
look the way you intended when viewed on another 
Macintosh.

2 Selecting the Data for the Macintosh Part 

a Choose Mac/ISO Hybrid from the Format menu and click 
Mac…. 

The Mac Volume selection window is displayed:
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b Highlight the temporary partition and check the option 
Optimize. Click OK.

3 Selecting the Data for the ISO Part

a Click ISO….

The empty selection window will be displayed. 

b Drag the same partition onto the window that you have 
selected for the Macintosh part.

All the data will be recognized as shared and will be written 
to the disc only once.

c Click the Settings tab.

d Select Joliet (MS-DOS + Windows95) from the naming 
menu

e Click Done.

f The size of the data selected is displayed in the main 
window.

g Check the data rate and write the disc. 
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Audio CD
The Audio CD format records audio tracks on the CD in the format 
used by standard consumer CD players.

Areas of Application
Use the Audio CD format to write a standard audio CD. The discs 
can be played on all audio CD players, as long as the audio data is 
placed in the first session of the disc. 

For detailed information on this format as well as its settings see 
“Toast’s Greatest Hits & Audio CDs” on page 6-35.

Introduction to Toast’s Greatest Hits
Toast’s Greatest Hits is a great new feature that lets you create audio 
CDs by simply dragging tracks from existing CDs or sound files 
onto the Toast track list. 

■ Tracks can be copied directly from the original CD without 
saving them to a hard drive first. You can even select tracks 
from different CDs and Toast will prompt you to insert the 
correct source CD while writing the new disc.

■ Toast can also write audio CDs from standard Mac sound files. 
Toast recognizes SoundDesigner II or AIFF sound files (they 
must be in 16-bit, 44.1 kHz format)

You can combine these two methods.

Note: Direct copying of audio tracks requires a CD-ROM 
drive that supports audio extraction and a Macintosh that 
supports SCSI Manager 4.3.
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Writing an Audio CD
1 Choose Audio CD from the Format menu. 

2 Click Audio….

The Audio Tracks window is displayed:

3 Drag the audio files or tracks that are to be written to the disc 
from the Finder onto the window:
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4 or click Add… and select the desired files. 

The selected items are displayed in the Audio Tracks window. 
You can click and drag on items in the list to rearrange them.

Note: Toast uses the disc and track names which have been 
entered with the AppleCD Audio Player. If the selected 
tracks have already been named, the names will appear in 
the track list.

If you select a track belonging to a CD that has not been 
named, Toast prompts you to give the CD a name:

You can also specify names for each track. Names entered in 
Toast are saved in the same database used by the AppleCD Audio 
Player.

5 Double-click on any item in the track list to display the naming 
dialog:

6 Enter the desired track name(s) then click OK. You can use the 
arrows to move to a different track. If you change the name of a 
track that is based on a sound file rather than a CD track, the 
name of the source file is changed. 
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7 Toast automatically inserts a 2-second gap between each track. 
If desired, you can specify a different gap using the Pause 
menu. The menu will set the pause before the selected track(s).

If your recorder does not support pauses of less than two 
seconds, you may see this message:

Check the Toast READ ME file on the installation disc for more 
information.

8 When all files are loaded, click Done.

The total length of the selected tracks will be displayed in the 
main window:

9 Click Check Speed….

Toast reads all the selected tracks to determine if your system 
is fast enough to write the disc in the chosen speed.
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If you have selected tracks from more than one CD, Toast will 
prompt you to insert the appropriate disc as it reads each track:

10 When the test is complete, click Done. 

11 Insert a blank recordable CD in your writer.

To make sure the inserted disc is empty, choose Disc Info from 
the Recorder menu.

12 Click Write CD….

If you have selected tracks from more than one disc, Toast 
displays a list of the discs you need:
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13 Make sure you have all the required source discs, then click 
OK. This window is displayed:

14 Verify that the desired writing speed is selected in the pop-up 
menu.

15 If you want to add data to this disc later, click Write Session. (If 
your audio files occupy more than 625 MB or if you selected 99 files 
this option is disabled.)

WARNING: Standard audio players can read tracks from the 
first session only!

16 If you want the disc to be closed so that no further data can be 
added later, click Write Disc.

The writing process begins at the selected speed. 

Toast prompts you to insert the appropriate source disc as it 
reads each track:

Note: Audio files cannot be verified after writing. 

For additional information on this format see “Toast’s Greatest Hits 
& Audio CDs” on page 6-35.
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CD-i
The CD-i (compact disc interactive) format is designed primarily for 
multimedia applications and games. CD-i discs require special 
playback equipment.

Areas of Application and Requirements
Use the CD-i format to write a disc that can be played on CD-i 
players.

■ To write a CD-i, you need a completely mastered CD-i disc 
image that contains the entire data and target files. Such 
images can be created with a CD-i authoring system such as 
MediaMogul. 

■ You can also load CD-i disc images that were created with 
“ASTARTE CD-Copy” from an existing CD-i. You cannot 
create CD-i links with Toast, or import “dyuv” files or videos 
into Toast.

For detailed information on this format as well as its settings see 
“CD-i Format” on page 6-42.

Writing a CD-i
1 Choose CD-i from the Format menu and click Data…. 

The standard file selection dialog is displayed:

2 Select the desired CD-i image and click Open. 

Or drag the disc image onto the main window.
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The size of the selected data is displayed in the main window:

3 Click Check Speed….

Toast reads the selected data to determine if your system is fast 
enough to write the disc in the chosen speed.

4 When the test is completed, click Done.

5 Insert a blank recordable in your CD recorder. 

To make sure the inserted disc is empty, choose Disc Info from 
the Recorder menu.

6 Click Write CD….

The following dialog box is displayed:

7 To add data to this disc later, click Write Session. (THIS IS 
NOT RECOMMENDED FOR CD-i FORMAT!).

8 To close the disc so that no further data can be added later, 
click Write Disc.

The writing process is started in the selected speed. 

CD-i data cannot be verified after writing. 

For additional information on this format see “CD-i Format” on 
page 6-42.
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Video CD
The VIDEO CD format is used to record full-motion video or movies 
on a CD. Playing a Video CD requires special equipment, including 
an MPEG decoding system.

Areas of Application and Requirements
Use the Video CD format to write a White Book-compatible Video 
CD that can be played on Video CD and CD-i players. A Video CD 
track must always be placed in the first session of a disc. 

To write a Video CD, you need the following data:

■ AVideo CD disc image, that contains the MPEG-stream(s), 
menu pages, and links (this file is created by a Video CD 
authoring systems) or 

■ MPEG streams that were created with “ASTARTE M. Pack” 
(version 1.02 or later).

Preparing Your MPEG Files
You have to use the following settings for encoding and 
multiplexing in “ASTARTE M. Pack”:

■ Basic Settings: Format ‘ Custom; Target System ‘ Video CD

■ Video: Format ‘ PAL or NTSC

■ Audio: Bit Rate ‘ 224 KBit/s

■ Multiplex: Toast-Ready ‘ checked.

Note: Video CDs created directly from M.Pack MPEG 
streams will not have menus; they simply play their video 
tracks in the order they were added to the list.

For detailed information on this format as well as its settings see 
“Video CD Format” on page 6-43.
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Writing a Video CD
1 Choose Video CD from the Format menu and click Data…. 

The following dialog box is displayed:

2 Choose one of the two possibilities:

a A Video CD image file

The standard file selector dialog, from which you can choose a 
disc image, is displayed.

b One or more MPEG streams

The following window is displayed:
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3 Enter the name for the disc, drag the MPEG-streams of your 
choice onto the window (or use the Add… button, and click 
OK.

4 The loaded data is displayed in the main window: 

a If you have loaded a disc image:

b If you have loaded MPEG streams:

5 Click Check Speed….

Toast reads all the selected data to determine if your system is 
fast enough to write the disc in the chosen speed.

6 When the test is completed, click Done. 

7 Insert a recordable CD in your writer.

8 Click Write CD….
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The following dialog is displayed:

9 Verify that the desired writing speed is selected in the pop-up 
menu.

10 If you want to add data to this disc later, click Write Session. 
(THIS IS NOT RECOMMENDED for VideoCD format!)

11 To close the disc so that no further data can be added later, 
click Write Disc.

The writing process begins at the selected speed. 

Video CD data cannot be verified after writing.

For additional information on this format see “Video CD Format” on 
page 6-43.
4-56



Supported Formats
Enhanced Music CD
The Enhanced CD (CD Extra, formerly known as CD Plus) format 
combines audio tracks and graphic files on a disc that can be played 
using special applications that allow you to view the graphics while 
hearing the sound.

Note: Creation of Enhanced Music CDs can be complex. This 
section is intended only as an overview of the process. We 
recommend that you refer to the documentation included 
with your Enhanced Music CD authoring system for more 
information.

Areas of Application and Requirements
Use the format “Enhanced Music CD” (or “CD Extra”, formerly “CD 
Plus”), if you want to write a Blue Book-compatible disc. An 
Enhanced Music CD track always occupies the second session of an 
audio CD. 

To write an Enhanced CD, you must create the associated file/folder 
structure as it is defined in the Blue Book, or you need a 
corresponding QuAC file created with the “Apple Interactive Music 
Toolkit™” (AIMT).

In the past an Enhanced CD was often misunderstood to be simply a 
disc that contained one audio session and any other data session (in 
HFS, ISO 9660 XA or Hybrid XA format) as its second session. Such 
discs do not actually comply with the Blue Book standard. If you are 
not concerned with compliance to the standard, you can write a 
second session using the techniques discussed earlier.

A CD Extra disc written with Toast is always written as a Hybrid 
disc with shared data for the Macintosh and the PC.

For detailed information on this format as well as its settings see 
“Enhanced Music CD Format” on page 6-45.
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Writing an Enhanced Music CD
Start with a CD that already has audio tracks written as its first 
session.

1 Copy the QuAC file onto a Macintosh volume. (If the volume 
already contains data, this data will also be visible on the 
Macintosh part of the disc)

 or

Create a CD Extra directory structure on a Macintosh volume. 

For details on QuAC files and CD Extra directory structures 
see “CD EXTRA Hierarchies” on page 6-47.

2  Choose Enhanced Music CD from the Format menu and click 
Data…. 

The following dialog box is displayed:

3 Highlight the volume that contains the required file structure 
or the QuAC file.

Toast will verify that the volume contains the required data 
structure for an Enhanced CD. If the structure does not 
conform to the Blue Book specifications, Toast will report 
which files or other elements are missing.

The selected data is displayed:
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If there was a QuAC file on the volume, Toast generates a CD 
Extra directory structure based on its contents. A new folder 
named “CD Extra” is then placed on the volume. 

4 The folder “CD Extra” contains all the data that is “shared” 
(visible on both the Mac and ISO parts of the disc). Although 
this data is visible on both the Macintosh and the PC it is 
written only once to the disc.

Drag any additional files that you want into the “CD Extra” 
folder. 

Note: Toast uses the MS-DOS naming conventions for the 
ISO part of this Hybrid disc. Make sure all your files and 
folders conform to the 8.3 naming format.

You can also drag aliases which point to items located on the 
same Mac volume onto the “CD Extra” folder. This allows 
shared data to be placed in different directory structures on the 
Macintosh and on the PC.

5 Click Check Speed….

Toast reads all the selected data to determine if your system is 
fast enough to write the disc in the chosen speed.

When the test is completed, click Done. 

6 Insert the disc that contains the audio session in your CD 
recorder.

To check if the inserted disc contains an audio session, you can 
choose Disc Info from the Recorder menu.

7 Click Write CD….
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The following dialog box is displayed:

8 If you want to add data to this disc later, click Write Session. 
(THIS IS NOT RECOMMENDED for this format!) 

To close the disc so that no further data can be added later, 
click Write Disc. 

The writing process begins at the selected speed. 

Enhanced Music CD data cannot be verified after writing. 

For additional information on this format see “Enhanced Music CD 
Format” on page 6-45.
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Example: Creating a CD Extra with Additional Data for 
Macintosh and PC

Your Situation and Your Goal:

You wish to produce an audio CD with additional computer data. 
The disc should conform to the Blue Book specification to have the 
“CD Extra” label. You created a QuAC file with the software “Apple 
Interactive Music Toolkit™”. This QuAC file contains all desired 
information about the audio tracks on the disc.

For marketing purposes you want to put an additional multimedia 
presentation that describes your company on the disc. This 
presentation was created with the authoring tool “Macromedia 
Director™”. You have created different applications (executables) 
for Macintosh and PC, but you want to share the supporting data 
files (Director™ documents and QuickTime™ movies).

Procedure:

1 Write all audio tracks on a blank CD-R. Be sure to choose the 
option Write Session, not Write Disc.

For more control over pauses, ISRC codes and MCN you could 
use the optional software “Toast CD-DA” for mastering the 
audio session. 

2 Prepare a Macintosh volume that contains only the following 
data:

■ The QuAC file,

■ The Director™ application for the Mac and

■ All Director™ documents and videos, which are accessed by 
the Mac and the PC application (in a folder named “DOCS”). 
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3 Choose Enhanced Music CD from the Format menu. Click 
Data….

4 Select the volume, check Optimize and click OK.

5 The following dialog box is displayed:

If there were more than one QuAC file on the volume you 
could now select the correct one. In this example there is only 
one QuAC file on the volume. Click Yes.

6 Go back to the Finder and see how the volume has changed:

Toast created a “CD Extra” folder out of the QuAC file which 
contains the directory structure defined in the Blue Book.

7 The folder “CD Extra” is shared, that is, it contains all the data 
that will be visible on the Macintosh and on the PC. All other 
items are visible only on the Macintosh.
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To make the multimedia application visible on the PC, copy 
the PC executable and other files needed on the PC into the 
folder “CD Extra”.

Then create an alias of the folder “DOCS” (it contains all 
Director™ documents and QuickTime™ movies which are to 
be shared) and drag this alias onto the folder “CD Extra” 
(don’t forget to change the name of the alias so that the PC 
application can find the folder and the contained files).

8 Go back to Toast, check the data rate, and write the disc. 

The integrity of the directory structure will be checked again 
before writing.
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SCSI Copy
SCSI Copy lets you copy directly from one SCSI device (such as a 
CD-ROM drive) to a CD.

Areas of Application and Requirements
Use the SCSI Copy format to create the exact copy of a SCSI device, 
for example, hard disks, CD-ROM  drives with a disc inserted, 
magneto-optical drives with a cartridge inserted, ZIP drives with a 
disk inserted, etc.

You must observe the following restrictions: 

■ Since SCSI Copy makes an exact copy of the volume, the 
resulting CD may not work as expected. For example, if you 
copy a volume which has been formatted as a DOS drive, it 
will not work properly on a PC; PCs require the ISO format for 
CDs, but your CD would have the format and structure of a 
hard disk.

■ You can faithfully copy and read Macintosh hard disks in this 
manner; however, we recommend using the Mac Volume 
format instead.

■ If you select an audio disc or a mixed mode disc, Toast uses 
SCSI Copy for the data part of the disc and the Audio Tracks 
option for the audio tracks. This is set up automatically.

■ You cannot copy discs that contain Mode2 Form2 sectors, for 
example, Video CDs, CD-i, Photo CDs, etc., because the 
Macintosh cannot read those sectors.

■ Discs to be copied must contain only one session, because the 
Macintosh cannot read the sectors between sessions. 

■ To copy discs with multiple sessions, you could use an 
application like “ASTARTE CD-Copy” that will save the 
contents of the disc as files that can then be written back to the 
disc with Toast.

For detailed information on SCSI Copy and its settings please see 
“SCSI Copy Format” on page 6-49.
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Writing a SCSI Copy
1 Choose SCSI Copy from the Format menu and click Data…. 

All connected SCSI devices are displayed:

2 Select the device to be copied and click OK. 

The following dialog box is displayed:

When you select a CD that you have written yourself, Toast 
automatically subtracts the unreadable blocks at the end of the 
disc to avoid errors while writing.

Changing these numbers may cause your disc not to work. 

3 Click OK.

The amount of data to be written is displayed in the main 
window:
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4 Click Check Speed….

Toast reads all the selected data to determine if your system is 
fast enough to write the disc in the chosen speed.

Note: If you are copying from a CD, make sure that the 
speed of the CD-ROM drive is higher than the selected 
writing speed. As a general rule, use a write speed that is 
1/2 the speed of the reader.

5 When the test is completed, click Done. 

6 Insert a blank recordable in your CD recorder. 

To verify that the inserted disc is indeed empty, you can choose 
Disc Info from the Recorder menu. 

7 Click Write CD….

The following dialog is displayed:

a If you want to add data to this disc later, click Write 
Session. 
(THIS IS NOT RECOMMENDED!) 

b To close the disc so that no further data can be added later, 
click Write Disc.

The writing process begins at the selected speed. 

For additional information on this format see “SCSI Copy 
Format” on page 6-49
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Example:Creating a Backup of a CD-ROM 

Your Situation and Your Goal:

You have written a disc in Hybrid format that is to be submitted for 
manufacturing. You want to create a backup disc for safety. You 
have at least one 2x CD-ROM drive at your disposal, so you can be 
sure that the speed will be sufficient to copy directly from disc to 
disc (2x readers can usually be copied at 1x, while a 4x reader can 
usually be copied at 2x). 

Procedure:

1 Insert the CD-ROM in your CD-ROM drive. 

2 Choose SCSI Copy from the Format menu and click Data….

The CD-ROM drive is connected on bus 0 with SCSI ID 3:

3 Select the appropriate drive from the list and click OK.
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The number of blocks on the disc does not correspond with the 
number of blocks to be copied, since a disc that you have 
written yourself always contains “run out” sectors at the end, 
that cannot be read by the Macintosh (see “Terminology” on 
page 3-4), Toast automatically excludes these blocks to avoid 
errors while writing.

4 Click OK, check the data rate and write the disc. 
4-68



Supported Formats
Disc Image

Areas of Application
The Disc Image format allows you to write a previously created disc 
image to a CD. You can use disc images created by Toast, as well as 
images generated by a variety of specialized tools.

A disc image is simply a single file, saved on your drive, that 
contains ALL the data and formatting information needed to create 
the CD.

You would use Disc Image format under these circumstances:

■ You have saved your selected data as a disc image in Toast (see 
“Save as Disc Image” on page 5-2).

■ You need to write an image to disc but don’t know its exact 
format.

■ You used a UNIX utility (like “mkisofs”) to create an ISO 
image with Rockridge extensions.

■ You saved the contents of an HFS, ISO 9660, Hybrid disc or 
other single-track CD-ROMs with “ASTARTE CD-Copy”.

Caution: When saving the contents of a Photo CD with 
“ASTARTE CD-Copy” the “Multitrack CD-ROM XA” 
format must be used, not the Disc Image format (see 
“Multitrack CD-ROM XA Format” on page 6-54).

For detailed information about this format please see “Disc Image 
Format” on page 6-52.

!
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Writing a Disc Image to CD
1 Select Disc Image from the Format menu and Click Data….

The standard file selection dialog is displayed:

2 Select the desired disc image and click Open.

The size and format of the selected data is indicated in the 
main window:

3 Click Check Speed….

Toast reads all the selected data to determine if your system is 
fast enough to write the disc in the chosen speed.

4 When the test is completed, click Done. 

5 Insert a recordable CD in your writer. 

To determine if the inserted disc is still recordable, you can 
choose Disc Info from the Recorder menu. 
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6 Click Write CD…. The following dialog box is displayed:

7 Verify that the desired writing speed is selected in the pop-up 
menu.

8 If you may want to add data to this disc later, click Write 
Session. (If your source volume contains more than 625 MB 
this option is disabled. ) 

9 If you want the disc to be closed so that no further data can be 
added later, click Write Disc.

The writing process begins at the selected speed. When all the 
data is written, Toast automatically verifies the data.

For additional information on this format see “Disc Image Format” 
on page 6-52
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Example: Creating, Mounting and Writing a Disc Image

Your Situation and Your Goal: 

After finishing a multimedia production in Hybrid Format you want 
to test the applications before actually writing the discs.

Procedure:

Begin by setting up your Hybrid disc, including selecting the 
Hybrid format and selecting the appropriate data for the Mac and 
ISO parts of the disc. 

1 Select Save as Disc Image… from the File menu..

A dialog box is displayed.

2 Select a hard disk with enough free space to hold the disc 
image file (check the Toast main window for details on how 
much disk space is required.)

A progress indicator is displayed while Toast builds the image 
file.

3 When the process is complete, double-click the saved disc 
image.

Toast automatically switches to the Disc Image format and 
selects the newly created image as the source.

4 Click the Mount button.
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Since you’ve created a Hybrid disc, two volumes are mounted 
on the desktop: one for the Mac part and one for the ISO part. 

You can now test items on the disc (Hybrid images are 
mounted as read-only so no changes can be made to the data.)

5 Once you are satisfied that everything is set up correctly, you 
can write the disc.
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Multitrack CD-ROM XA

Areas of Application
The Multitrack CD-ROM XA format is used to write a disc with 
several CD-ROM XA tracks in one session.

Note: This format is seldom used, as most CD formats 
consist of only one data track per session. Its most common 
use is for copying Photo CDs with a tool like “ASTARTE 
CD-Copy”. 

For detailed information about this format see “Multitrack CD-ROM 
XA Format” on page 6-54.

Writing a Disc with Several XA Tracks
1 Select Multitrack CD-ROM XA from the Format menu. Click 

Data….

The CD-ROM XA dialog is displayed:

2 Click Add… and select the desired CD-ROM XA files or drag 
the files into the window.

The Names, Sizes, and Block Sizes of the selected files are 
displayed. You can drag the items to change their order in the 
list.

3 After selecting all files click OK.
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The total size of the selected tracks is displayed in the main 
window:

4 Click Check Speed….

Toast reads all the selected data to determine if your system is 
fast enough to write the disc in the chosen speed.

5 When the test is completed, click Done. 

6 Insert a recordable CD in your writer. 

To determine if the inserted disc is still recordable, you can 
choose Disc Info from the Recorder menu. 

7 Click Write CD…. The following dialog box is displayed:

8 Verify that the desired writing speed is selected in the pop-up 
menu.

9 If you may want to add data to this disc later, click Write 
Session. (If your source volume contains more than 625 MB 
this option is disabled. ) 

10 To close the disc so that no further data can be added later, 
click Write Disc.

The writing process begins at the selected speed.
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Mixed Mode CD

Areas of Application & Requirements
The Mixed-Mode format is used to combine one data track and 
several audio tracks in a single session.

This format has been largely replaced by “CD Extra” (see “Enhanced 
Music CD Format” on page 6-45).

■ The data portion of a Mixed Mode CD can be any of the Toast 
formats. 

■ The audio tracks can be set up using the normal techniques 
(see “Toast’s Greatest Hits & Audio CDs” on page 6-35).

Writing a Mixed Mode CD

1 Select the desired data format, then Audio Tracks from the 
Format menu.

Two buttons are displayed in the main window: Data… and 
Audio…. 

2 Click Data….

Select your data. For details see the chapter on the selected 
data format.

3 Click Audio….

The audio track selection window is displayed:
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4 Click Add… and select the desired audio files or drag the 
audio files into the window.

File name, time, and number of index-points is displayed in 
the track window. 

5 After selecting all the desired audio files click OK.

The total size of the selected tracks (data and audio) is 
displayed in the main window:

6 Click Check Speed….

Toast reads all the selected data to determine if your system is 
fast enough to write the disc in the chosen speed.

7 When the test is completed, click Done. 

8 Insert a blank recordable CD in your writer. 

9 Click Write CD…. The following dialog box is displayed:

10 Verify that the desired writing speed is selected in the pop-up 
menu.

11 If you may want to add data to this disc later, click Write 
Session. (If your source volume contains more than 625 MB 
this option is disabled. ) 

12 To close the disc so that no further data can be added later, 
click Write Disc.

❒
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The Menus
The File Menu
The File menu consists of the following items:

Open

Opens previously saved Toast files (or virtual images). Open 
restores all the settings and file selections to the same state as when 
the file was saved.

Save / Save as

Saves a virtual image containing references to all selected data, 
settings, and modified file names so they can be restored later.

Virtual images can be created for every format. 

Toast generally asks if you want to save your current settings when 
you quit the application or switch to a different format.
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Note: Since a virtual image saves references to selected files, 
but not the files themselves, the image is invalid if the 
original data is deleted.

Revert

Reverts to the last-saved Toast document (virtual image).

Save as Disc Image 

Saves all selected data as a single file. This file contains all the data 
for the CD, not just the settings.

Disc Images can be written to a CD at any time, even if the original 
data has been moved or deleted.

You might want to create a disc image

■ If your Mac is too slow to write or optimize on-the-fly.

■ If you are writing data from a network volume or CD that 
doesn’t have sufficient speed to write directly.

■ If you want another person to write the discs, but don’t want 
them to be able to change the contents or layout of the disc.

Properties of disc images:

■ They contain all needed data (as opposed to virtual images 
which only contain references to the data).

■ Most disc images can be mounted to check contents and 
functionality (Video CD disc images cannot be mounted). 

■ Mounted disc images appear just like any other volume on the 
desktop. 

■ If the disc image was created from a Mac format (Mac Files & 
Folders or Mac Volume), the contents can be modified after 
mounting (all other disc images appear as a write-protected 
volumes)

Mounting a disc image:

■ Select Mount Disc Image from the Utilities menu.
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Note: Only defragmented disc images can be mounted (the 
entire image file must reside on contiguous blocks on your 
hard disk). Use a commercial disk optimizer like Norton 
Speed Disk™ to defragment if necessary.

To save a disc image and write the CD all in one step select the 
option Create Disc Image first after clicking Write CD… on the 
main screen.

Quit

Exits the Toast application, after asking you to save your settings 
(when appropriate).

Note: Clicking the Close box in the main window is the 
same as selecting the Quit command.

The Edit Menu
The Edit menu consists of the following items:

Standard Functions

Undo, Cut, Copy, Paste, Clear and Select All are standard Macintosh 
functions that are available for use in any of Toast’s lists or error 
logs.

The Copy function can also be used to copy all selected items as text 
in the “ISO 9660” and the “Mac Files & Folders” dialog (see 
“Copying the Contents as Text” on page 6-12).
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Preferences

Displays a dialog box that allows you to set the following 
operational parameters:

Disk Cache

In addition to the RAM cache, Toast uses your hard disk to 
temporarily store small files while optimizing and writing on-the-
fly. 

If you have more than one hard disk attached to your Mac, you can 
specify which drive to use for this temporary storage:

Select the fastest drive that has sufficient free space. 

Note: Don’t select an optical drive or other slow storage 
devices as the Disk Cache.
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RAM Cache

Toast uses RAM installed in your Macintosh to augment the RAM 
cache built into your recorder. 

The amount of RAM Toast uses for Cache Enhancement is 
selectable:

You can choose a relative amount, based on the selected write speed, 
or you can set a specific amount of RAM to be used, regardless of the 
write speed.

In general, if you are writing CDs from data sources with erratic 
data rates (like network volumes), you should set a higher value. On 
the other hand, if you generally write from a very fast hard drive on 
a fast computer, small values should work just fine.

Note: Cache Enhancemen works only if your Mac supports 
SCSI Manager 4.3 and if you have asynchronous hard disk 
drivers installed.

Preferred Drive for Reading Audio

If you have more than one CD-ROM drive on your system, you can 
use this menu to specify which drive ejects when Toast requests an 
audio disc. 

The TEST button checks the selected drive to verify that it has audio 
extraction capabilities. This test requires an audio disc in the drive.

Calculate a checksum while verifying

When this option is checked, Toast calculates a checksum each time 
it verifies a disc. This is useful if you are writing CDs from image 
files created in another application that also calculates a checksum 
(such as Astarte CD-Copy). You could then compare the two values 
to ensure that the disc is identical to its source.
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Once it is calculated, you can select Copy to copy the Checksum to 
the clipboard.

Note: if you don't have software that generates images and 
checksums, don’t check this option.

The Format Menu

The Format menu is used to select the specific CD format that you 
want to write. See the appropriate chapter of this manual for 
detailed descriptions of each format.

You can also 
switch formats 
using the popup 
menu on the 
main screen
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The Recorder Menu
The Recorder menu contains commands related to the functioning 
of the CD recorder.

Write Speed

Allows you to specify what speed to use when writing a CD. Only 
the speeds that are applicable to your recorder are available in the 
menu.

Note: You can also set the write speed in the write dialog 
after clicking Write CD… (see “Speed” on page 7-9).

Simulation Mode

Selecting Simulation Mode allows you to test the entire writing 
process without actually writing any data to your blank CD. This is 
an accurate way to ensure that you have a sufficient data transfer 
rate before writing a CD.

The words ***Simulation Mode*** are displayed in the menu bar in 
red when Simulation Mode is active.

Note: When you write a CD using Simulation Mode, it looks 
just like the disc is actually being written. The record light 
on the CD writer is even lit. But as long as SIMULATION 
MODE appears in the menu bar, no data is written to the 
disc.

Simulation Mode can also be set in the Write dialog box after 
clicking Write CD… (see “Simulation Mode” on page 7-9).
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Disc Info

Select this command to view information about the CD currently 
inserted in the recorder:

Available information includes:

– Media type (recordable or not)

– Any existing sessions that may be on the disc

– Amount of disc space used and available

– Whether the disc can accept additional sessions

Recorder Info

This command displays technical information about the connected 
CD recorder. To determine the firmware version of your recorder, 
use this command..
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Eject

Ejects any currently inserted CD from the recorder.

Mount CD-ROM

This will cause any mountable sessions that may be on the currently 
inserted disc to appear on the Mac desktop. Once a disc is mounted, 
it can be used normally until you eject the disc or restart the 
computer, even if you exit the Toast application.

It is not necessary for the Toast CD Reader extension to be installed 
for this function to work. 

The Utilities Menu
The Utilities menu consists of the following items:

Mount Disc Image

Mounts a previously created disc image on the Mac desktop. All 
images except Video CD images can be mounted.

Mounted images function just like any other volume.

Mounted HFS Images can be modified, all other formats are 
mounted as “read only”.

Note: Only defragmented disc images can be mounted (the 
entire image file must reside on contiguous blocks on your 
hard disc). Use a commercial disc optimizer like Norton 
Speed Disk to defragment if necessary.

Images can also be mounted by clicking Mount on the main screen in 
the Disc Image format (see “Disc Image Format” on page 6-52).
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Create Temporary Partition

This command allows you to create an empty disk image file of any 
size which can then be mounted and used to set up data to be 
written to a CD.

Temporary partitions are useful in situations where you want to 
have complete control over the layout of your data and how its 
windows are arranged and displayed.

Since temporary partitions are automatically created with 2K 
allocation blocks, they can also make it possible to have shared data 
on a hybrid CD, even though your hard drive may not have the 
required block size. (see “About Block Size and Shared Data” on 
page 6-32 for more information on shared data.)

Follow these steps to create a temporary partition:

1 Select Create Temporary Partition.

2 Enter name and size for the partition.

3 Select the hard disk where you want the image file for this 
partition to reside.

4 Click OK.
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Caution: Temporary partition files must reside on 
contiguous blocks on your hard disc. 

If sufficient contiguous space is not available, Toast reports an 
error:

Compare

The Compare command compares the contents of two data sets to 
see if they match. You can compare two volumes, two folders, or 
two files:

Note: Compare differs from the Verification function which 
Toast performs after writing a CD in two significant ways. 
First, Verify always compares the selected source data to the 
finished CD; with Compare you can compare any two data 
sets. Second, Compare checks each individual file when 
comparing the data; the Verify function compares only 
blocks. This means that the Compare function can usually 
tell you exactly which file contains the error.

1 Choose Volumes, Folders, or Files from the pop-up menu.

!
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2 Select the desired original and copy.

3 Click Compare.

If any mismatches are found, Toast displays a list:

You can select items from the list and simply drag them to the 
desktop to create a text-clip file (requires the Apple Clipping 
extension). Open the clip by double-clicking its icon.

Check Aliases

Examines all the aliases on a specified volume to make sure they all 
point to items on the same volume and that all the original files can 
be found.

Always check aliases before writing in Mac Volume or Hybrid 
format.
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After choosing Check Aliases, select the desired volume and click 
OK.

Aliases are checked, and any problems are displayed in a list:

You can drag items from the list to the Finder for later use:

Be sure to delete or correct any nonfunctional aliases before writing 
your CD.

Make System 6 Compatible

Choosing this command causes Toast to build a System 6-type 
desktop file on the selected volume that will be written on the CD. 
This is required if the disc will be used on Macs running System 6.

Select the desired volume and click OK. 

The desktop file is created on the volume.
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Autoloader

To automatically write a series of discs, select this item. After writing 
one disc Toast waits for a new discs to be inserted and starts writing 
when the recorder is ready. 

■ Use Autoloader: Check this option to use the Autoloader 
option.

■ Type: Select the desired Autoloader type. To use this function 
even if you have no autoloader system select the Generic 
option. You can then insert a new disc yourself as soon as one 
disc is finished. If you want to write several discs with the 
same contents, this function helps save time and avoid errors.

■ Stop on error: Checking this option causes Toast to stop 
writing any additional discs if it encounters an error while 
writing or verifying. We recommend always using this option.

■ Write log file: Select this command to have Toast keep a log 
file of all events during a writing session.

■ Verification: The Verify command lets you specify which discs 
should be verified while writing multiple discs with an 
autoloader system. 

Note: Verifying takes as long as writing. To minimize the 
time it takes to verify, uncheck the option Calculate a 
checksum while verifying in the Preferences (Edit menu).
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After clicking Write CD… in the main window, the following dialog 
box is displayed:

Enter the number of copies to be written.

To close so that no further data can be added later, check the option 
Fixate Discs. 

After clicking Start the following dialog is displayed:

❒
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Settings for Each Format
Mac Volume Format 
The volume selection window is displayed after you click Data…:

This window lists all available volumes/partitions along with 
information about their status.

Comments

Only volumes listed as ok to write can be selected as the data source 
for a Mac Volume CD.
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Other possible comments are listed here, along with suggestions for 
correcting problems.

The Optimizer

Background

The built-in optimizer is one of Toast’s most useful features. Its 
unique technology allows you to do things that were previously 
impossible:

■ You can now reliably write a CD from a fragmented data 
source

■ You can write CDs that seem to hold more data, by allowing 
Toast to select the optimum block size

■ You can write CDs that mount more quickly and feel more 
responsive, by having Toast position every file at the beginning 
of a sector.

■ You can select any mounted volume as your data source, even 
the startup volume and volumes with files in use.

Comment Information Possible Solutions

Startup volume This volume contains the Check “Optimize on-the-fly”.
active System Folder Open files can then be written.

Busy This volume contains the Check “Optimize on-the-fly”.
currently used Toast Open files can then be written.
software.

Shared The volume is currently Turn off Filesharing in the
being shared. Sharing Setup control panel

Audio CD, The volume is not an Write the volume using SCSI Copy,
ISO 9660, HFS volume. or use another software tools to
High Sierra, convert the contents into writable
MFS format (e.g. "ASTARTE CD-

Copy").

Foreign The volume is not an HFS Select the data in “Mac Files &
File System volume, it is e.g a DOS Folders” or in “ISO 9660” format.

formatted hard disk.

Server Volume The volume is a server Select the data in “Mac Files &
volume. Folders” format.
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■ You can change your data right up to the time you write the 
CD, without having to worry about creating fragmentation (as 
would be the case if you used normal optimizers.)

Functionality of the Optimizer

Unlike typical disc optimizers, Toast’s optimizer works while the 
disc is being written.

■ Nothing is changed on the source volume, so there is no risk to 
your data.

■ The directory and desktop files for the CD are written at the 
beginning of the disc, greatly reducing seek time for finished 
disc, and further increasing responsiveness.

The Optimizer’s Settings

You can choose between two different optimizer strategies: 

■ Optimize For Size

■ Optimize For Speed

The option Optimize for Size looks for the smallest possible block 
size and uses it for the CD. This means that if you have many small 
files, you might be able to save more data onto a disc than you can 
without optimizing.

The option Optimize for Speed looks for the smallest possible block 
size which is a multiple of 2048. This ensures that each file starts at 
the beginning of a CD sector (1 CD sector = 2048 bytes), which 
speeds up access times. (When writing a Mac/ISO Hybrid disc this 
option is the only available as the ISO 9660 system is based on CD 
sectors.)

An extreme example:

You have 20,000 files, all smaller than 512 bytes. 

Using Optimize for Size requires a block size of 512 bytes; the 
volume needs : 512 * 20,000 = 10 MB. 

Using Optimize for Speed a block size of 2048 bytes is used, the 
volume needs: 2048 * 20,000 = 40 MB.
6-3



Toast User’s Guide
Other Advantages of the Optimizer

■ Even if your system configuration is not fast enough to 
optimize on-the-fly, you still save time when saving the 
volume as adisc image and you get a disc that is optimized for 
CD and not for hard disk

■ No errors occur in the file structure of finished discs, as the 
optimizer creates a fresh structure as it works. You might even 
be able to write from a volume with a damaged file structure.

Disadvantages of the Optimizer

■ Higher hardware requirements: Power Mac or 68040 with 25 
MHz, SCSI Manager 4.3 support and a fast hard disk.

■ The optimizer requires more available RAM: about 1 MB for 
each 3000 files, plus 4 MB for 2x write speed, 6 MB for 4x write 
speed.

Both issues can be resolved by saving the volume as disc image 
before writing (see “Save as Disc Image” on page 5-2).

Don’t copy free space

Selecting Don’t copy free space causes Toast to ignore any portion 
of the source volume after the last block that contains data.

This option allows you to use a source volume larger than the 
capacity of the CD, as long as the defragmented data does not use 
more space than the CD has available.

Note: if you select one of the optimization methods, then 
this option is not available (or needed).

Caution: Your data should be defragmented for this option 
to be useful; empty blocks that are “buried” among the used 
blocks are not considered to be free. (see "The Info Dialog" 
below)

!
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Bootable CDs
Select the Bootable option to create a CD that can function as a 
startup disc when used in an Apple-brand SCSI CD-ROM drive. 

For the bootable option to work, the source volume must contain a 
functional System Folder that works on the specific Macintosh 
model(s) that you want to use the disc in. A System Folder that 
works on one Mac (a PowerMac for example) will not necessarily 
work properly on a different Mac model. Be sure you construct a 
System Folder that is appropriate for the target machine(s).

Caution: A Trash and a Desktop-Folder are created as soon 
as you click this option; this can be annoying if the finished 
disc will be shared over a network; do not select the 
bootable option if you don’t need it.

To actually boot from a bootable CD, you must press a special key 
code while the Macintosh starts up:

■ On some Macs, you simply press and hold the “c” key until the 
“Welcome To Macintosh” message appears.

■ On other models, you have to press and hold the Command, 
Option, Shift and Delete keys (simultaneously) until the 
message appears.

■ You can also use the Startup Disk control panel to set the CD as 
the startup device.

AutoStart

Using the AutoStart option, you can specify a file/application that 
opens automatically whenever the CD is mounted.

■ When you click the AutoStart option, a standard file selection 
window appears. Simply select the desired file and click Open. 

■ To change the selected file, click on its name in the rectangle. 
The selection window is then again displayed.

Caution: The name of the item selected must be 11 characters 
or less, and the file must reside at the root level of the drive. 

!

!
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If you select a file (rather than an application) to AutoStart, be sure 
that the application needed to open that file will be available on the 
target system.

Info Dialog 
Once you’ve selected a volume in the Select Volume window, the 
Info… button will be available. Click the button to display this 
informational window:

The upper portion of the window shows a graphic representation of 
the data on your disk. The blue areas show blocks that contain data, 
while gray areas show empty blocks. (If you save and delete data 
frequently on your hard disk, it may appear highly fragmented, 
with many gray areas “buried” within the blue area.) 
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Note: Toast only recognizes free space after the last data 
block. (Free space between data blocks is not recognized.)

If you use NORTON FILE SAVER, the Size of CD-ROM always equals 
the size of the volume selected, since FILE SAVER stores its invisible 
files at the very end of the drive. Deactivate FILE SAVER using its 
control panel to prevent this.

The items in the lower left part of the window display details about 
the volume you’ve selected, including the total size of the volume 
and its block size, along with the amount of space used by files, and 
the amount of free space. 

To the right of the volume information is the Size of CD-ROM info. 
This number shows how much space is required on the CD to be 
able to write all the data from the selected volume. 
If the volume is fragmented, the space required will be larger than 
the actual space used (as shown to the left). 

Note: When Optimize on-the-fly is checked, the information 
shown in this window may not be accurate. 

Check Aliases
Before writing a Mac Volume, it’s a good idea to use the Check 
Aliases command to ensure that any aliases on the CD will function 
as expected (see “Check Aliases” on page 5-12).
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Mac Files & Folders Format 

The Main Window
The main file selection window lists all the files and folders that you 
have selected for inclusion on your CD. Changes that you make in 
this window change the contents of the CD.

All directories are displayed in alphabetical order. The list behaves 
very much like a standard directory window in the Finder which is 
sorted “by name”.

Click on the arrow to the left of the disc or folder name to “open” the 
item and display its contents. Click the arrow again to “close” the 
item.

Note: To open all folders at once hold the Option key while 
clicking an arrow. Repeat the procedure to close all folders.

Creating a New CD / a New Folder
If the selection window is empty, you can create a new CD by 
clicking the New CD button.

An untitled CD icon appears in the list. You can then add other 
items to the CD by dragging and dropping, or by using the Add… 
button.

If the selection window already contains some items, the New 
Folder button is available.. Click it to create a new, empty folder at 
the same level as any selected item. If no item is selected when you 
click the New Folder button, the new folder is placed at the root 
level.
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Importing the Data
1 Drag & Drop Method

To add files and/or folders to the list, simply select their icons in the 
Finder and drag them onto the Toast window.

2 The Selection Method

Click the Add… button.

Select the desired item from the file selection dialog box and click 
Add. Repeat as often as required to add all the items you want.

Click Done when finished.

Renaming Folders, Files and the Disc & Changing Visibility
You can change the name of files, folders and discs, as well as setting 
their visibility property without affecting the original items on your 
drive.

To change the name of an item in the list, double-click it.

The Information window is displayed:
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Enter the new name and click OK.

To make a file or a folder invisible check the Invisible checkbox. 
When checked, the item will be written to the CD, but will not be 
visible in the Finder.

Invisible items are displayed in gray in the list.

Note: Two desktop files are always written onto each CD – 
"Desktop DB" and "Desktop DF" (see below). These files are 
always invisible, regardless of how you set their “Invisible” 
property.

About the Desktop Files

The Desktop files contain information that the Mac operating 
system uses to determine which icon should be associated with each 
file or folder. Normally, each Mac volume has its own desktop files. 
These files are updated automatically by the System, whenever you 
copy new items to that volume.

Because Toast makes it possible to assemble a CD from files and 
folders located on several different volumes, it is possible that the 
desktop files may not contain all the icons needed to properly 
display each item. Toast attempts to use the desktop files that will 
yield the best result, but in some cases you may want to override its 
choices.

Here is how Toast gets its desktop file information:

If a folder is dragged from a local volume into the empty window, 
the desktop files of the volume where that folder resides are 
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selected. If you start by selecting a folder from a nonlocal volume, 
the desktop files of the startup volume are used.

To select the desktop files of a special volume, start with an empty 
Toast window and import any folder (it can even be empty) from 
that volume. Toast will then use the desktop files from that volume.

Selecting Items
To select a single item in the list, simply click on it. To select more 
than one item, use one of these methods:

■ Drag a selection-rectangle around the items with the mouse. 

■ Click the first item, hold down the Shift key and select the last 
item to select all items in between.

■ To select items which are not next to each other in the list, hold 
down the Command key while clicking the items.

■ To select all items in the list choose Select All in the Edit menu.

Removing Items
To remove selected items use the Backspace key, choose Clear from 
the Edit menu or click the Remove button.

Caution: Removing items cannot be undone. If you 
accidentally remove the wrong item you must reselect it.!
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Copying the Contents as Text

To copy the contents of the list as text select Copy from the Edit 
menu. The text can be pasted into any other application.

Modifying the Hierarchy
You can reorganize the hierarchy of the CD by dragging items in the 
list. You can move items to different folders or move folders until 
you have the layout you want.

Caution: If you change the contents of a folder by moving 
items in the Toast file selection window, then its appearance 
will no longer match the original when written to the disc. 
(See below "The Appearance of Windows on the Disc")

Resolve Aliases
If the data you select for your disc contains aliases, you can 
determine how those aliases are treated when the CD is written.

Resolve Aliases checked‘the original files are written onto your CD

Resolve Aliases not checked‘the aliases are written to the CD

Caution: If you decide not to resolve aliases, make sure that 
the aliases are still valid once they are written to the disc. 

The Appearance of Windows on the Disc
If the contents of an imported folder is not changed, the appearance 
of the window is exactly the same as in the original folder (this 
includes the view settings, window size, and window position).

!

!
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If items are added to a folder that were not in the original folder, the 
contents are displayed according to these rules:

■ If the folder contains 9 items or less, its contents are sorted by 
icon. (If you use long file names, they may overlap when 
viewed this way.)

■ If a folder contains more than 9 items it is sorted by name.
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The Order of Files on the Disc
Files/folders are written onto the disc in alphabetical order, as 
shown here:

Data is written defragmented to leave the maximum amount of free 
space for additional sessions.

Mac HFS Discs with Several Sessions
An HFS disc with more than one session is a multi-volume disc. This 
means that each session will always appear as a separate volume on 
your desktop.

Depending on which CD-ROM driver you use, you may initially see 
only the first session when you insert a multi-volume disc in your 
CD-ROM drive. 

■ Apple CD-ROM driver Version 5.0.x and lower: 

Only the first session is automatically mounted.

■ Apple CD-ROM driver Version 5.1.1 and higher:

All sessions are automatically mounted as separate volumes 
on the desktop.

■ Toast CD-Reader Version 2.0 and higher (to use your recorder 
as a player):

All sessions are automatically mounted as separate volumes 
on the desktop.

1
2
3

4
5
6

7
8

9
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ISO 9660 Format 
The ISO File Selection window has three parts: Files, Layout and 
Settings. You can switch between the parts by clicking the tabs at the 
top of the window:

■ Files: selecting the data

■ Layout: determining the layout or order of the files on the disc

■ Settings: setting the options for file naming, format, etc.

Files 

The Main Window

The main file selection window lists all the files and folders that you 
have selected for inclusion on your CD. Changes that you make in 
this window will change the contents of the CD.

All directories are displayed in alphabetical order. The list behaves 
very much like a standard directory window in the Finder which is 
sorted “by name”.

Click on the arrow to the left of the disc or folder name to “open” the 
item and display its contents. Click the arrow again to “close” the 
item.

Note: To open all folders at once hold the Option key while 
clicking an arrow. Repeat the procedure to close all folders.
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Creating a New CD / a New Folder
If the selection window is empty, you can create a new CD by 
clicking the New CD button. An untitled CD icon appears in the list. 
You can then add other items to the CD by dragging and dropping, 
or by using the Add… button.

If the selection window already contains some items, the New 
Folder button will be available. Click it to create a new, empty folder 
at the same level as any selected item. If no item is selected when 
you click the New Folder button, the new folder is placed at the root 
level.

Importing the Data
1 Drag & Drop Method

To add files and/or folders to the list, simply select their icons 
in the Finder and drag them onto the Toast window.

2 The Selection Method

3 Click the Add… button.

Select the desired item from the file selection dialog box and 
click Add. Repeat as often as required to add all the items you 
want.
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4 Click Done when finished.

Renaming Folders, Files and the Disc & Changing Visibility
You can change the name of files, folders and discs, as well as setting 
their visibility property without affecting the original items on your 
drive.

To change the name of an item in the list, double-click it.

The Information window is displayed:

Enter the new name and click OK. 

To make a file or a folder invisible, check the Invisible checkbox. 
When checked, the item will be written to the CD, but will not be 
visible in the Finder.

Invisible items are displayed in gray in the list:

Selecting Items
To select a single item in the list, simply click on it.
6-17



Toast User’s Guide
To select more than one item, use one of these methods:

■ Drag a selection-rectangle around the items with the mouse. 

■ Click the first item, hold down the Shift and select the last item 
to select all items in between.

■ To select items which are not next to each other in the list, hold 
down the Command key while clicking the respective items.

■ To select all items in the list choose Select All in the Edit menu.

Removing Items
To remove selected items use the Backspace key, choose Clear from 
the Edit menu or click the Remove button.

Caution: Removing items can not be undone. If you 
accidentally remove the wrong item you will have to 
reselect it.

!
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Copying the Contents as Text

To copy the contents of the list as text select Copy from the Edit 
menu.Depending on the naming option selected, one of these 
windows is displayed: 

■ All items: all items in the selection window are copied as text.

■ Renamed items or Items with Illegal Names: only renamed or 
illegal items are copied as text.

The text can be pasted into any other application.

Modifying the Hierarchy
You can reorganize the hierarchy of the CD by dragging items in the 
list. You can move items to different folders or move folders until 
you have the layout you want.

Resolve Aliases
If the data you select for your disc contains aliases, you can 
determine how those aliases are treated when the CD is written.

■ Resolve Aliases checked the original files will be written onto 
your CD

■ Resolve Aliases not checked the aliases will be written to the 
CD.
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Caution: Aliases only work on Macintoshes; if the ISO disc 
you are creating will be used on other systems BE SURE TO 
SELECT RESOLVE ALIASES so the original items will 
copied to the CD!

Note: If you are working on a hybrid disc, aliases that point 
to items on the selected Mac volume will be resolved by 
using shared data.

Layout

The Order of Files on the Disc

If no changes are made in the Layout portion of the files selection 
window, then the files are written in the following order:

Files are written defragmented to leave the most possible space for 
more sessions.

In most cases the standard layout is adequate.

!
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However, you can change the order in which the files are written on 
the disc for special purposes.

To change the order, simply move selected files to the desired place 
in the list.

■ Files located at the top of the list will be written first (towards 
the inner part of the disc).

■ To place selected files on top or at the bottom click Move to top 
or Move to bottom, respectively.

Note: You can move more than one item at a time. See above 
for information on selecting files in the list.

Settings

Format Settings
Use the Format pop-up menu to select the desired format for your 
ISO disc.
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CD-ROM

This format should be used for single session CDs, and CDs that will 
be duplicated by a replication plant. Some very old CD-ROM drives 
can only read CDs in this format.

Note: If you select CD-ROM format, you will not be able to 
add sessions to the disc later.

CD-ROM XA

Select CD-ROM XA format for multisession discs, so you have the 
possibility of adding sessions later.

Caution: When a Hybrid track is written as a second session 
of an audio CD this format has to be used. 

Electronic Book

The Electronic Book format is rarely used.

Naming Settings
The Naming menu lets you specify how Toast should handle file 
names that are not compatible with the ISO file format.

Toast automatically transforms file or folder names so they conform 
to the selected naming option.

The Files list displays the transformed name, along with the original 
name (in gray).

!
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Note: To see all transformed (or illegal) names choose Copy 
in the Edit menu, then select All items or Renamed items (or 
illegal names) from the dialog that appears. You can then 
paste the list into any text processing application.

ISO 9660 Level 1

This is the original ISO naming format and is very restrictive (most 
systems don’t need pure ISO standard).

Name requirements:

■ Length: 8.3 characters

■ Characters: uppercase letters A-Z, numbers 0-9 and the 
underscore _. No other characters are allowed.

■ Examples: ISO_NAME.TXT, IMAGE_1.TIF

ISO Level 1 has a limitation of 8 levels of nested directories. Toastl 
allow you to have more than 8 levels but the data might not be 
readable on many systems (you will be warned before trying to 
write an ISO disc with more than 8 levels).

Allow MS-DOS Names

Similar to ISO Level 1 but not as restrictive. Use this option for discs 
intended for DOS or Windows 3.x systems.

■ Length: 8.3 characters

■ Characters: uppercase letters A-Z, numbers 0-9, the underscore 
_ and these special characters:{ } @ - ^ ! $ % & ( ) ` ´ # ~ 

ISO format has a limitation of 8 levels of nested directories. Toast 
allows you to have more than 8 levels but the data might not be 
readable on many systems (you will be warned before trying to 
write an ISO disc with more than 8 levels).

Allow Macintosh Names

This option causes Toast to leave all file and folder names as they 
are. Use this option if you are using ISO format discs to make 
incremental backups from your Macintosh.
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Caution: Discs created with this naming option can be used 
only on Macintoshes!

Joliet (MS-DOS& Windows95)

This is an extension to the ISO format that allows the disc to 
preserve long file names for use under Windows95 and 
WindowsNT, while also being fully compatible with older versions 
of DOS and Windows.

A Joliet format disc contains two file systems: An ISO 9660 
compliant file system using MS-DOS names, and the Joliet file 
system using long Unicode names. Both file systems point to the 
same data files. Remember that only Windows 95 and Windows NT 
4.0 systems will have access to the long names, while ISO 9660 
compliant systems such as MS-DOS, Unix, or Mac OS will only see 
the ISO 9660 file system. A Mac/ISO hybrid disc created with Joliet 
names will actually contain three different file systems: HFS, ISO 9660 
and Joliet.

Name requirements:

■ Length: 31 characters

■ Characters: These characters are not allowed */:;?\

■ Example: 1998 Report to Shareholders

Toast does not change file names when Joliet is selected. Instead, 
illegal names (containing */:;?\ ) are flagged with three red 
exclamation marks in the file list.

!
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You can use the "Copy" command in the "Edit" menu to export a list 
of all illegal names to the clipboard.

Viewing the Short Names under Joliet

To view the short names seen by MS-DOS or (if you're not creating a 
hybrid disc) Macintosh systems go to the "Settings" panel and 
switch to "Allow MS-DOS Names". 

Note: If you change a short name the long (Joliet) name will be 
changed too.

Other Settings

Append Version Numbers (;1)

This option adds the standard ISO version number (;1) to every file 
name. This version number is normally invisible, and is seldom 
needed. This option is not available with Mac names.

Caution: The installed ISO driver does not usually display 
version numbers even if they are on the disc. If you want to 
see full names on the Mac press the Option key while 
inserting the disc.

Use Apple Extensions

Check this option to have Toast write both the data and resource 
forks for Mac files.

This has no effect when the disc is read on a PC.

!
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For hybrid discs this option is not needed, as both forks are always 
written to the HFS part of the disc.

Set Defaults

Clicking this button will preserve your current settings as the 
default for future Toast sessions.

More

Clicking the More… button lets you enter a variety of additional 
information that will be written to the disc as part of the directory. 

Note: In most cases this information is not visible or 
accessible to the user.

Concerning Rockridge Extensions for UNIX
Toast cannot create discs with the Rockridge extensions for UNIX. It 
can, however, write images created by UNIX utilities such as 
“mkisofs” which do incorporate Rockridge name extensions. 

The Appearance of Windows on the Disc
On a Mac all windows of an ISO disc will be sorted by icon.

Note: If you use ISO format to make backups for a Mac, you 
might want to use short files names so that they don’t 
overlap when viewed by icon.
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ISO 9660 – Multisession Format
This section covers adding an ISO 9660 session to a disc that already 
contains at least one additional ISO session. There are several 
different strategies that can be used when adding an ISO session. 
Each approach is covered below.

Before deciding which approach to use, you need to know what 
relationship the data in your new session has to the existing data. 
For example, does the new data supersede the old data? Or is it 
additional data that should be stored along with the old data?

The three primary strategies are:

■ Ignore old sessions

■ Append to old sessions

■ Incremental backup session

Adding an ISO Session
To add a new ISO session to a disc, begin by selecting your new data 
in the normal fashion (see “ISO 9660” on page 4-17)

Once your data is selected, click the Write CD… button in the main 
window.

This dialog box appears:

Ignore Existing Sessions

Choosing this option produces a CD that appears to contain ONLY 
the data from the new session. All old data will be gone (it’s not 
actually gone, since CDs cannot be erased, but you are no longer 
able to access it.)
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Note: There is no way to view these old sessions. Only use 
this option if you are sure that older sessions are no longer 
needed.

Append to “Name of the previous Session”

This option results in a disc that has the name of the new session as 
its volume name or label and has both the new data and the old data 
together in the “top” level of the directory structure.

It is also possible to selectively “delete” folders from the structure. 
For example, let’s assume that the folder “John” is no longer needed. 
In the ISO dialog create a new folder, give it the name “John” and 
define it as Invisible (see “Renaming Folders, Files and the Disc & 
Changing Visibility” on page 6-9). Then add any new data you may 
want, and write the session. The new data will be added to the 
structure and the folder “John” is no longer visible.

Incremental Backup

Selecting Incremental Backup causes Toast to write only the files and 
folders that have changed since the last session. 

In this example, two folders 
named “John” and “Smith” 
were originally written as a 
session named “Backup”

A second session named 
“Backup II” was added; it 
contained one folder named 
“Francis”.

Notice that the disc is now 
named “Backup II” and that 
the folder “Francis” appears 
at the same level as the old 
folders.
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Note: For this to work correctly you need to select the same 
volume or folders for each session. If you select completely 
different data, the results of an incremental backup is the 
same as if you selected “Ignore existing sessions”.

Importing a Session from a Disc
For the ultimate in control, Toast allows you import the directory of 
previous ISO sessions and then edit and make any changes you 
want. You can delete, rename, move, and reorganize any of the files 
and folders of the old sessions.

To import an existing session, make sure the CD is in your recorder, 
then:

1 Click the arrow on the lower right side of the window and 
select Import Session.

If there is at least one ISO session already written on the disc, 
the Import Session dialog box is displayed:

2 Select the desired session (usually the most recent session) to 
import.
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Note:  If you import a session other than the most recent one, 
you will not be able to see any data from the sessions 
written after the one you have imported!

3 Specify how you want the session to appear in the new 
session’s directory by clicking one of the radio buttons.

If you select Merged, the name of the session becomes the 
name of the new session and the data of the old session 
becomes the data for the new session.

If you choose Put into a directory the old session is put in a 
directory with the name of the session. If no data was selected 
before, a new CD directory is created containing one folder 
which contains the data from the old session.

4 Click OK.

The imported session is displayed in the ISO directory window. Files 
that are already written on the CD are marked with a small CD icon 
by their name.

Modifying an Existing File Structure

At this point you can make changes to the file structure.

You can make any or all of these changes to the structure:

■ Files and folders can be moved to another position.

■ Files and folders can be added or removed

■ Files, folders, and the disc can be renamed.

■ The visibility of files and folders can be changed.

■ New data can be added to any part of the directory structure.

The way you arrange the data determines the layout of the disc once 
you write the new session. 

Note: To conserve disc space, files already on the disc are not 
written to the disc again; the directory structure is simply 
altered to match your changes.
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Removing an Imported Session

To remove an imported session from the ISO directory window, 
select Remove Imported Session from the pop-up menu in the 
lower right corner of the window. All the files and folders from the 
imported session are removed from the window, leaving only new 
data that you may have added.
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Mac/ISO Hybrid Format
This section covers the creation of Mac/ISO Hybrid discs. Hybrid 
discs may seem complex at first, but if you follow the simple 
guidelines presented here, it’s a snap.

Preparing the Mac Portion of a Hybrid Disc
For a hybrid disc, the Mac data must be by itself on a volume or 
partition.

This volume or partition should contain all the data for the Mac 
portion of the disc, as well as all the data shared by both the Mac 
and ISO portions. 

You can arrange the data in any way, and the shared data may be 
located anywhere in the directory structure of the Mac volume.

About Block Size and Shared Data

To write a hybrid CD containing shared data (data visible on the 
Mac and the PC), the block size of the Mac volume must be a 
multiple of 2048 Byte (2 K), unless you choose the Optimize option 
in the volume selection window.

The block size of the volume is shown in the Info… dialog.

If the block size of the selected Mac volume is not a multiple of 2 K, 
you have these options:

■ You can check the option Optimize for Speed (“Optimize for 
Size” is not available in Hybrid format), which will allow the 
data to be shared. 

■ You could simply choose to write the common data to the disc 
twice, once for the Mac part and once for the ISO part. (This of 
course requires that there is enough room on the disc for two 
copies of the shared data.)

■ You can create a temporary partition using Toast for use as 
your Mac data source. Temporary partitions created with Toast 
automatically have the correct block size for shared data. 

■ Reformat your hard disk and choose a compatible block size.
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The ISO Part of a Hybrid Disc
The data for the ISO portion of a hybrid disc can reside anywhere on 
your hard drives. You simply drag the desired files and folders into 
the ISO window in Toast to select the data.

■ If you select data for the ISOpart is located on the volume you 
selected as the source of the Mac data, that data will 
automatically be shared, and hence will be written to the disc 
only once.

■ If you select data from other volumes or directories, it is visible 
only on PCs.

Why Multisession Hybrid Discs are a Bad Idea

Creating a multisession Hybrid disc is generally not recommended 
for these reasons.

■ No link can be established between the different sessions, 
which means you would end up with a multi-volume disc.

■ On the PC only the data of the last session is visible; earlier 
sessions are ignored. (On a Mac each session appears as a 
separate volume.)

Note: It is okay to write a Hybrid session as the second 
session after an audio session. An audio CD player would 
then see only the audio tracks, while computers will see 
both audio and data.

Testing your Hybrid Disc Before Writing

You can test the layout and contents of a hybrid disc before writing 
to make sure it is set up correctly.

1 After selecting all the data, choose Save as Disc Image from 
the File menu.

The Mac and the ISO part are saved as a single disc image file.

2 Select Mount Disc Image from the Utilities menu..

Two volumes are mounted on the desktop: one for the Mac 
part and one for the ISO part. You can then open the volumes 
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to review their contents. (No changes can be made to volumes 
mounted in this manner.)

You can then review the layout of both volumes, and make any 
desired changes befor writing the image to disc using the DISC 
IMAGE FORMAT. (Select Disc Image Format and choose the 
saved hybrid disc image as the source.)
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Toast’s Greatest Hits & Audio CDs
Toast’s Greatest Hits lets you create audio CDs by simply dragging 
tracks from existing CDs or sound files onto the Toast track list. 

• Tracks can be copied directly from the original CD without saving 
them to a hard drive first. You can even select tracks from different 
CDs and Toast will prompt you to insert the correct source CD while 
writing the new disc.

• Toast can also write audio CDs from standard Mac sound files. 
Toast recognizes SoundDesigner II or AIFF sound files (they must be 
in 16-bit, 44.1 kHz format)

You can combine these two methods if desired.
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Note: Direct copying of audio tracks requires a CD-ROM 
drive that supports audio extraction, a recorder that 
supports direct copying and a Macintosh that supports SCSI 
Manager 4.3.

Selecting Tracks
There are two methods of selecting audio files or tracks for writing 
to a CD.

1 Drag & Drop Method

Select the desired audio files in the Finder and drag them onto 
the main window.

When selecting from an audio CD, you can drag one or more 
tracks, or simply drag the icon of the disc to select all the 
tracks.
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2 The Selection Method

a Clicking the Audio… button in the main Toast window will 
display the Audio Tracks window, shown here:

b Click Add… and select the desired files in the dialog box 
that appears. To import all files in a given folder, click Open 
while the contents of that folder is displayed.

Rearranging the Audio Files
You can drag the individual audio tracks around in the Audio 
Tracks window to change the order that they appear on the finished 
disc.

Removing Tracks
To remove tracks from the list, select the desired files and click 
Remove.

Caution: Removing items from the list cannot be undone, 
but you can reimport the file if you remove something from 
the list by mistake.

!
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Previewing Tracks
To play a track select it in the Audio Tracks window and click the 
Play button. The track is played back using the Mac’s internal audio 
output. If the track is on a disc which is not currently mounted, you 
are prompted to insert it.

Caution: Playing audio tracks requires the system extension 
“Sound Manager”.

Saving Tracks as Sound Files (Audio Extraction)
Toast can save an audio track as a standard AIFF sound file. Simply 
select the desired track or tracks in the track list and click the Extract 
button. You are prompted for a destination for the files.

Note: When you extract a track, Toast updates the track list 
to refer to the extracted file, rather than to the source CD for 
that track.

Naming Your Source CDs & Tracks
For convenience while organizing and writing compilation discs, 
Toast uses the disc and track names that have been entered with the 
Apple CD Audio Player. If the Apple database contains names for 
any tracks selected, those names are used by Toast.

You can edit these names using Toast, or with the Apple CD Audio 
Player.

• To edit the names with Toast, double-click on any item in the track 
list to display the naming dialog box:

!
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Enter the desired disc and track name(s) then click OK. You can use 
the arrows to move to a different track. (If you change the name of a 
track which is based on a sound file, rather than a CD track, the name of the 
source file will be changed.) 

• To edit the names using the Apple CD Audio Player, select the 
player from your Apple menu:

Enter the desired disc and track name(s) in the appropriate fields.

Writing from multiple source discs
If you have selected tracks from more than one disc, Toast displays a 
list of the discs when you click the Write CD button.

Make sure you have all the required source discs available before 
proceeding, as the write process cannot be aborted once begun.
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While writing, Toast prompts you to insert the appropriate source 
disc as it reads each track:

The Pause between Tracks
Toast automatically inserts a 2-second gap between each track. You 
can specify a different gap using the Pause menu. The menu sets the 
pause before the selected track(s).

If your recorder does not support pauses of less than 2 seconds, you 
may see this message:
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Note: Toast records in Track-at-Once mode (not Disc-at-
Once mode). When the gap is set at 0 seconds, a few frames 
are written between each track, resulting in a pause of a few 
milliseconds.

Check the Toast READ ME file on the installation disc for more 
information.

Index-Points – Text and Numeric Markers
If you have defined index points in your SoundDesigner II files, 
Toast recognizes them and writes them to the disc. To read the 
markers in your sound files, select the marker type from the Index 
pop-up menu.

Choose Text Markers or Numeric Markers depending on the type of 
markers you defined. The number of markers is then displayed in 
the track list.

Note: Index-points are seldom used, because most audio CD 
players cannot use them (or even see them).

Not all CD writers are able to write index-points in track-at-once 
mode (the mode used by Toast). If your writer does not support 
index points, a dialog box is displayed to warn you when you try to 
write the CD.
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CD-i Format
Toast can write a CD-i disc from a CD-i image; these disc images are 
generated by various CD-i authoring systems like Media Mogul from 
Philips.

Toast cannot create CD-i disc directly from “dyuv” or video files.

Scrambling
Toast can accept CD-i disc images that are scrambled or 
unscrambled. The application automatically detects the file type and 
writes the disc accordingly.
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Video CD Format
Toast can create a Video CD in two ways:

■ By writing a Video CD disc image created by a Video CD 
authoring system

■ By using individual MPEG streams multiplexed with 
“ASTARTE M. Pack”

Video CDs can be played on Video CD players, CD-i players, and 
computers with MPEG decoder cards.

A Video CD from a Disc Image
All menu pages, links, and MPEG streams defined in your Video CD 
authoring software will be written to the disc when writing from a 
disc image.

A Video CD from MPEG Streams
When you create a Video CD from one or more MPEG streams, the 
resulting disc will not have menu pages or links. It functions more 
like an audio CD. The following functions will be available when 
playing the disc in a Video CD or CD-i player:

■ Play first (or only) video

■ Jump to the next video if available

■ Fast forward and rewind

■ Pause

■ Stop

For more flexibility in your Video CDs, you can create them using an 
authoring system and then write the discs using a disc image.

Adding MPEG Tracks to a Video CD
After selecting Video CD from the Format menu, click the Data… 
button in the main window.

The MPEG Tracks window appears.

Click the Add… button to select files to be added to the track list. 
You can also specify a name for the disc (if desired).
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Changing the Order of the Tracks
To change the order of MPEG tracks, select them and drag them to 
the desired position in the list.

The order of the files in the list determines the order of the tracks on 
the finished disc.

Removing MPEG Tracks from the List
To remove imported MPEG-streams from the list, select the desired 
files and click Remove.
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Enhanced Music CD Format

Note: Creation of Enhanced Music CDs can be quite 
complex. This section is intended only as an overview of the 
process. We recommend that you refer to the documentation 
included with your Enhanced Music CD authoring system 
for more information.

An Enhanced Music CD, also called CD Extra and formerly known 
as CD Plus, is a disc that contains audio tracks in the first session 
and a data track in the second session. The data track has to conform 
to the specifications of the Blue Book, which requires a precisely 
defined file structure.

■ Toast creates Mac/ISO hybrid Enhanced Music CDs with 
shared data.

■ Toast supports the creation of 100% Blue Book conformant 
discs.

Steps to Creating an Enhanced Music CD
The first step in creating an Enhanced Music CD with Toast is to 
create an Audio CD containing the desired tracks.

Be sure to choose Write session rather than Write disc when 
creating the audio disc, or Toast will not be able to append the 
Enhanced Music CD session to the disc.

Toast is able to create Enhanced Music CDs from

■ A pre-made CD EXTRA directory hierarchy, or

■ AQuAC file.

Using a pre-made Hierarchy

1 Launch Toast and set the disc format to Enhanced Music CD.

2 Click the Data... button and select a volume to be used for the 
CD.

– If you already have a valid hierarchy, just select a Macintosh 
HFS volume that contains the “CDPLUS” and “PICTURES” 
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directories in a directory called “CD EXTRA” at its root 
level.

– The root level “CD EXTRA” folder is used to create the ISO 
part of the CD. 

– Toast checks the integrity of the directory hierarchy and 
report any problems found. 

See “CD EXTRA Hierarchy” below for further details.

Using a QuAC File

To create an Enhanced Music CD from an existing QuAC file, simply 
put the file into the root directory of a Macintosh HFS volume. 
When you select the volume, Toast asks you whether you want to 
use the QuAC file to make an Enhanced Music CD and creates a 
directory hierarchy from the QuAC file for you. 

See “QuAC Files” below for further details.

All Enhanced Music CD discs created with Toast are hybrid 
Macintosh HFS / ISO-9660. The ISO part contains all the files in the 
“CD EXTRA” folder of the Macintosh volume.

Files in the “CD EXTRA” folder are automatically shared, with two 
exceptions: 

■ INFO.CDP is duplicated in the ISO part, because it has to be 
placed at relative sector address 75 according to the Blue Book 
standard. 

■ The MPEG pictures are not shared because they are recorded 
in form 2 sectors.

Before Toast writes the disc, it verifies the integrity of the data 
structures. If there are no problems, the relative sector offset 
addresses will be updated and the CD written.

QuAC Files
In 1995 Apple introduced the QuickTime Audio Containable 
standard for documents that contain information for music CDs as 
well as pictures and optional interactive controls.
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When you choose a QuAC file as your data source for a Enhanced 
Music CD, Toast will create a structure like this:

lc = language code, e.g. “de” for german, “en” for english, etc.

nn = Track number; 01, 02,… for the single tracks, 00 for the whole 
album

Toast only creates files for which data actually exists, but it always 
creates the INFO.CDP, at least one SUB_INFO.lc, and four picture 
files.

Picture files are created for the front cover picture of the album only. 
Toast substitutes MPEG files using a set of internal replacement 
pictures (showing the CD EXTRA logo). You can replace these files 
with your own sectorized MPEG pictures in the proper resolutions 
(NTSC or PAL).

The QuAC file appears at the root level of the ISO volume.

CD EXTRA Hierarchies
Toast can also make an Enhanced Music CD disc from a manually 
constructed directory hierarchy. The structure has to be similar to 
the one described in “QuAC Files” above.

Toast CD-ROM will verify several parts of the directory structure 
before starting to write it to CD. In particular, Toast will check the 
following criteria:

Directories

A “CDPLUS” and a “PICTURES” directory must be present in the 
“CD EXTRA” directory in the root directory of the Macintosh HFS 
volume.

Mac Volume CD EXTRA CDPLUS INFO.CDP
SUB_INFO.lc
LYRICSnn.lc
TRACKnn.MID

PICTURES JACKET01.00J
JACKET01.00N
JACKET01.00S
JACKET01.00T

AUTORUN.INF

The QuAC File
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INFO.CDP

The file “INFO.CDP” must be present in the “CDPLUS” directory. It 
has to conform to the Blue Book specifications and contain space for 
pointers to each of the ”SUB_INFO.lc“ files.

SUB_INFO.lc

The “SUB_INFO.lc” files have to be valid, that is, they have to 
conform to the Blue Book specifications and contain space for 
pointers to each of the “TRACKnn.MID”, “LYRICSnn.lc”, and 
picture files.

AUTORUN.INF

If there is no “AUTORUN.INF” file in the “CD EXTRA” directory of 
the HFS volume, Toast will creates a simple file with just the line 
“[autorun]” in it. You can edit this file, but remember to save it in 
CRLF format.

Picture Files

Toast only accepts picture files with file extensions of the form nnx 
(e.g. JACKET01.00J or VANESSA.01J) where nn is a track number (or 
00 for the whole album) and x is the format type which could be any 
of J, N, T, S, P, A, or L.

At least the JPEG files have to be present; MPEG files will be 
substituted using Toast’s built-in set of MPEG replacement pictures 
(showing the CD EXTRA logo) if they are missing.

If MPEG files are present, they have to be fully sectorized (2352 
bytes/sector). They must not be scrambled. The header and sync 
fields will be patched during recording, but the subheader has to be 
correct.
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SCSI Copy Format
SCSI Copy is used to make a direct copy from a hard drive, CD-
ROM drive or other SCSI volumes, to a CD. It is ideal for making 
exact copies of existing data CDs.

When you click the Data… button while in SCSI Copy mode, this 
window is displayed:

If your Mac has more than one SCSI bus, select the desired SCSI Bus 
from the pop-up menu to view the devices connected to that bus.

Searching the SCSI Bus
If you switched on a SCSI device after opening this window the 
device will not appear in the list. Click Re-Scan to search the SCSI 
bus and list new devices.
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Options
After you have selected a device in the list, the Options… button 
will be available. Click it to set these options:

Normally both options should be checked. If you are copying a 
bootable CD, uncheck “Clear Driver Descriptor Map”.

You can accept the default settings if you don’t have special 
requirements. 

The Amount of Data to be Copied
After selecting a device to copy, click OK. This window is displayed:

SCSI copy normally copies the entire volume, even if not all the 
space contains data.

You can change the number of blocks to be copied to eliminate the 
copying of empty space. You should only change these settings if 
you are very sure of what you are doing. Incorrect settings can result 
in a useless disc.
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Note: When copying a disc you have written yourself, the 
Number of Blocks to copy will be less than the total number 
of blocks on the disc. Toast makes this adjustment 
automatically, since the Mac cannot read the last blocks 
from a CD-R.

Caution: Mac volumes should not be copied using SCSI 
Copy; it is always preferable to use the “Mac Volume” 
format.

When Copying a CD
Copying a CD only works under these conditions

■ The disc may only contain one track in one session.

■ The disc may only contain sectors that can be read by the Mac: 
Mode1 or Mode2 Form1 sectors.

■ Discs containing Mode2 Form2 sectors cannot be copied as the 
Mac cannot read those sectors.

■ Your CD-ROM drive must be faster than your selected 
recording speed. For example, if you want to record the copy at 
2x, your CD reader must be at least a 4x.

Note: To copy audio CDs use the Audio CD format and drag 
the icon of the audio disc onto the track list window to select 
all the tracks.

!
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Disc Image Format
Disc Image format is used to write a previously saved disc image to 
a CD. Disc images can be created in Toast, by using the “Save as Disc 
Image” command. Disc image files can also be generated by some 
multimedia authoring systems and other specialized applications. 

Note: Video CD or CD-i disc images created in their 
respective authoring systems should always be written in 
the corresponding format, NOT the Disc Image format.

When you select Disc Image format for a disc, the Data… button 
displays this file selection dialog:

Auto-Detect Format

Turning on this checkbox sets Toast to automatically determine the 
appropriate CD format for any disc image that you select. Normally 
you should leave this option checked.

To set the format options manually, uncheck the Auto-Detect Format 
checkbox. When you select an image and click Open, the following 
dialog box is displayed:

Change these settings only when really necessary!
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Pregap and Postgap

You can change these from the standard settings.

Sector Size 

The Sector Size is set automatically according to the contents of the 
disc image. You can change it using the pop-up menu.

Scrambled

If the selected disc image is NOT scrambled, uncheck the Scrambled 
checkbox.

Once you have selected an image file, and click Open, the size and 
format of the data is displayed in the main window.

Mounting Disc Images
You can mount the selected disc image as a volume on the desktop 
to check its contents. Simply click the Mount button. (If no image 
file has been selected, clicking the Mount button displays a file 
selection dialog box.) 

Note: If you mount a Mac/ISO Hybrid disc image two 
volumes will be mounted on the desktop, one for the Mac 
part and one for the ISO part of the disc image.

Caution: A disc image file must be stored in contiguous disk 
space in order to be mounted. If your disc image is 
fragmented, use a commercial disk optimizer (e.g. Norton 
Speed Disk) to defragment the volume which contains the 
image.

A disc image can also be mounted by selecting Mount Disc Image 
from the Utilities menu.

!
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Multitrack CD-ROM XA Format
This format is used for writing several CD-ROM XA tracks in one 
session. Most CD-ROM formats consist of only one track per session 
and therefore the “Multitrack CD-ROM XA” format is very seldom 
used.

When you select the Multitrack CD-ROM XA format, and click the 
Data… button, this track selection window is displayed:

Use the Add… button to select the XA image files that you want to 
include on the disc or drag them onto the window.

Options for XA Tracks

The Options… button allows you to change the block size for the 
select track:

It is normally set to the correct value automatically so don’t change 
it unless absolutely necessary.
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Audio Tracks Format
The Audio Tracks format is used to add audio tracks to another data 
format to create Mixed Mode CDs. The data and audio are written in 
one session. The data track is always placed before the audio tracks 
on the disc and there is no way to change this order.

Note: If you write a CD with audio tracks selected but no 
data, the result will be a standard audio CD.

Caution: If you write a disc in this format with both data and 
audio tracks, the data track should not be played in a 
standard audio CD player. Because the data is part of the 
first session, the audio recorder would be able to “see” the 
data tracks. Playing data tracks can be harmful to an audio 
system, especially speakers.

The Mixed Mode format has generally been superseded by the 
audio/data Multisession format where the first session consists of 
audio tracks and the second session consists of data (CD Extra or 
second session in HFS, ISO 9660 XA, Mac/ISO Hybrid XA format). 
Using this format the data track is not visible in audio CD players. 
(Some older CD-ROM driver software will not mount audio/data 
multisession discs. See the publisher of your CD driver for more 
information.)

❒

!
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Writing Discs
What is Transfer Rate?
To successfully write a CD, Toast must be able to get your computer 
to supply a steady stream of data to the recorder. How fast the data 
must be supplied depends on the writing speed and disc format that 
you’ve selected.

The speed of data flow is called the Transfer Rate; it indicates how 
many kilobytes of data are transferred in one second from the Mac 
to the writer. 

This chart shows the transfer rates required for different formats and 
writing speeds:

Checking the Transfer Rate
To minimize wasted discs, Toast gives you two different tools for 
verifying that you have adequate transfer rates: Check Speed and 
Simulation Mode (Simulation Mode is covered later in this chapter).

Write Audio & HFS, ISO, Hybrid
Speed Mode2 Form2 Mode1 / Mode2 Form1

1x 172 K/s 150 K/s

2x 344 K/s 300 K/s

4x 689 K/s 600 K/s

6x 1033 K/s 900 K/s
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You can check the transfer rate before writing to see whether your 
system is fast enough to write with the desired speed.

To run the Check Speed procedure, click the Check Speed… button 
in the main window (make sure you have selected your data first!). 
This window is displayed and the checking begins automatically:

The speed check proceeds as follows:

1 If you checked the option Optimize in Mac Volume or 
Mac/ISO Hybrid format the Optimize progress window 
appeas while the files are rearranged.

2 The RAM cache is then filled with data read from the source 
volume. (The size of the RAM cache is set in the Preferences 
dialog in the Edit menu.)

3 The Recorder cache is filled.

4 All selected data is read.

The two vertical bars indicate how much data is currently 
stored in the RAM caches. The downward-facing arrows mark 
the lowest point that the cache level reaches during the 
checking process.

It is normal for the levels to fluctuate during testing; however, 
if the Recorder Cache bar reaches the bottom at any time 
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during the speed check, it means that the data rate is too low. If 
that happens, the FAILED indicator appears:

Caution: Do not write the disc with these settings, as the 
write procedure will most likely fail and the CD will be 
wasted!

To check the data rate for a different writing speed or a 
different recorder model, click the Stop button, then make 
your new selection from the Simulation or Speed menus, and 
click Start. (These menus are initially set to match the 
connected recorder.)

Note: Check Speed is only an approximation (the data is 
read but not transferred to the writer). If the results of the 
speed check are borderline, try Simulation Mode, which 
gives a more accurate evaluation.

!
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Error Messages

You might get the following error message while checking the 
transfer rate:

This can happen if you try to copy one of the following CDs using 
SCSI Copy mode: 

■ CD-i, Video CD, Photo CD, CD Extra or

■ Another disc with audio or Mode 2 Form 2 sectors or

■ A disc containing more than one track or 

■ A disc containing more than one session.

Do not try to write the disc if you get this message!

If you want to copy such a disc you will need to obtain special 
software that converts the tracks into readable files, for example 
ASTARTE CD-Copy.

What to do if “Check Speed” fails
If “Check Speed” fails you can 

■ Set the write speed to a lower value. For details see “The Write 
Procedure” on page 7-6.

■ Use an AV hard disk with no thermal recalibration while 
writing (please refer to your dealer for details about your hard 
disk).

■ Turn off all unnecessary system extensions. If you use System 
7.5, you can boot with all extensions off (hold down the shift-
key while starting your Mac).
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Note: Toast does not require any extensions to run, however, 
if you are copying from a CD you will need to run the 
appropriate driver software for your CD-ROM drive. Also, 
on older Macintoshes, you may need to run the SCSI 
MANAGER, the THREAD MANAGER and the DRAG & 
DROP MANAGER extension to take advantage of some of 
the features of Toast.

■ Turn off all network connections when writing data placed on 
local volumes.

■ Remove all devices from your SCSI chain that are not presently 
needed. Some devices slow down the SCSI bus (especially 
removable media drives and scanners.)

■ Check cables and terminator. Slightly defective cables or 
terminators can slow down the SCSI bus, even though the 
effect may not be noticeable in normal use.

■ If your Mac supports SCSI Manager 4.3:

– Increase the RAM Cache (Preferences from the Edit menu).

– Make sure your hard disk driver is able to work in 
asynchronous mode (With System 7.5 the driver 
information is displayed in the “Get Info” dialog for the 
hard disk in the Finder.)

■ Create a disc image of the selected data before writing. Please 
refer to the next section for details.
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The Write Procedure
After satisfying yourself that the transfer rate is adequate, you are 
ready to write the disc.

■ Insert a recordable CD with enough free space to write the 
selected data. (To check the free space available on a disc, 
choose Disc Info from the Recorder menu.)

■ Click Write CD….

■ If there is no disc in the recorder this message appears:

■ Toast now verifies that it can locate all the data that you 
selected.

If you selected many files this procedure may take a while. (If 
you are sure that you didn’t move or rename any items after 
selecting them you can skip the verification.)
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If one or more selected items could not be found, an error 
report is displayed:

If you click OK Toast removes these items from the list 
anddoes not write them to CD. Click Cancel if you want to 
locate the files and reselect them in the data selection window.

■ If you chose ISO 9660 format and the inserted disc already 
contains at least one session, the ISO Multisession dialog box is 
displayed:

Click on the desired option to determine how the new session 
is linked to existing sessions. 
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■ If you checked the Optimize option, Toast prepares for the 
optimization process (if your data contains many small files, 
this can take some time):

■ If there is not enough free space on the disc for the selected 
data, Toast warns you:

You cannot write the disc if there is not enough space for the 
selected data.

■ If Use Autoloader or Use Kodak Disc Transporter (Utilities 
menu) was selected, this box appears:

Enter the number of copies you want to be written. To close the 
disc so that no further data can be added later, check Fixate 
Discs.

■ The Write dialog box appears
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The Write Dialog Box

The Write dialog box lets you set a variety of options for the writing 
process.

Speed
Use the Speed menu to select the desired writing speed (this menu is 
a duplicate of the Write Speed menu in the Recorder menu). Only 
those speeds that apply to your recorder are available.

The last write speed used in Check Speed is set by default.

Simulation Mode
Simulation Mode allows you to run through the entire process of 
writing the disc, exactly like the real writing process, except that the 
laser is not turned on in the recorder, so nothing is written to the 
disc.

■ All error messages that would be displayed while writing will 
also be displayed in simulation mode.

■ Simulating the write procedure takes the same amount of time 
as writing.

■ When simulation mode is selected *** Simulation Mode*** is 
displayed in the menu bar in red letters.

Note: During simulation, the write indicator light on the 
recorder turns on, just as if you were actually writing. This 
is normal, and does not indicate that the disc is really being 
written.
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The simulation mode gives more exact results than “Check Speed” 
since the data is actually transferred to the writer. (see “Checking the 
Transfer Rate” on page 7-1).

Create Disc Image first
If your Mac is not fast enough to write with the selected speed or to 
optimize a Mac volume while writing you can choose to create a disc 
image of the selected data before writing the disc.

If you check this option, the disc image is created and then writing 
begins automatically, using the image as the source.

Note: If you are not sure that the transfer rate is high enough 
to write the disc image with the desired speed, use the Save 
as Disc Image command from the File menu after selecting 
the data. Then choose the Disc Image format to write the 
saved disc image and check the transfer rate again.

Writing a Session
Click Write Session if you want to be able to add additional data to 
the disc at a later time.

If you checked the option Create Disc Image first you are asked to 
select the place to save the image file. The image file takes the same 
amount of disc space as the selected data.

Note: If you are not sure whether you will add more 
sessions to the disc later, choose Write Session. However, if 
the disc will be used as master for a duplication plant it 
should always be closed.

The Write Session command is not available if:

■ The selected data occupies more than 625 MB.

■ There would not be enough space left on the disc to write 
another session.

■ You write in ISO 9660 or Mac/ISO Hybrid format and you did 
not select the CD-ROM XA option for the format (see “Format 
Settings” on page 6-21).
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Caution: Each new session on a disc requires additional 
space to hold the directory structure.

■ The first session uses approximately 23 MB

■ Each additional session takes approximately 12.5 MB. 

Consequently, if you write many small sessions, the disc holds less 
data than if you write larger sessions.

Writing a finalized Disc
To write the selected data and close the disc so no more data can be 
added later, click Write Disc. 

If you checked the option Create Disc Image first you are asked to 
select the place to save the image file. The image file takes the same 
amount of disc space as the selected data.

Note:  If the disc will be used as master for a duplication 
plant it should always be closed.

These 9 sessions use a total space of 
52.1 MB if you just add up their sizes.
In theory that would leave 598 MB 
available when starting with a CD-R 
with 650 MB of free space.
However, Toast shows that is only 474 
MB available; 124 MB was used for 
the sessions´ overhead.
Theoretically you could write a disc 
containing 99 sessions each having 
approximately 6.56 MB of data (6.56 
MB x 99 = 649.44 MB). But because 
of the additional overhead you can 
only have 33 sessions each using 
6.56 MB. ((6.56 MB + 23 MB) + (32 x 
(6.56 MB + 12.5 MB))) = 639.48 MB.

!
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After Writing
After all the data is written the following dialog box is displayed:

If you do nothing or if you click Verify, the newly written data is 
compared with the original data on a block level.

■ If there is a data mismatch Toast displays a notification dialog.

■ If both the original and the copy are identical, you get the 
following message:

Note: Audio CDs, CD-is, Video CDs, Enhanced Music CDs 
and Multitrack CD-ROM XA discs cannot be verified after 
writing.

If the option Calculate a checksum while verifying in the 
Preferences (Edit menu) was checked, the checksum is displayed 
after verifying.

■ Select Copy from the File menu to copy the checksum or 
simply write it down.

❒
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Toast Audio Extractor
The Toast Audio Extractor, or TAE, is a simple application that 
allows you to save tracks from an audio CD as Mac sound files in a 
variety of formats. It requires a CD-ROM drive that supports audio 
extraction.

Getting Started
Launch TAE by double-clicking its icon in the Finder. After a 
moment the main window is displayed. If an audio CD is already 
mounted, its contents are shown in the window; if not, insert one to 
begin.
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The Main Window
You can control all of the application’s functions from this window.

Track List
The track list shows the number, title (if available) and length of all 
the tracks on the CD. The names are taken from the AppleCD Audio 
Player’s database. If you have previously named the tracks using 
the Apple player, those names are displayed in the track list.

Track list
Operation 
controls

Zoom 
Controls

Previewed 
Tracks Track Display area Current sound 

format setting
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Naming the Disc and Its Tracks
To edit the names with TAE, double-click on any item in the track 
list to display the naming dialog box:

Enter the desired disc and track name(s) then click OK. You can use 
the arrows to move to a different track. The names are stored in the 
Apple CD database and are available to any applications that use 
that data (Toast, TAE, and AppleCD Audio Player, among others).

The Track Display
The Track Display area shows a graphic representation of each track 
on the disc. Initially, each track is indicated by an open rectangle (as 
show here).

To view the waveform of one or more tracks, simply select them in 
the track list or track display and click the Preview button. The 
progress window appears while TAE reads the tracks and builds the 

Each track on the disc is 
indicated by a rectangle
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waveforms. This may take a while, depending on the length of the 
tracks and the speed of your CD-ROM drive.

About the Overlap option
TAE attempts to preview and extract audio data at the full speed of 
your CD-ROM drive. On some drives, this may result in errors that 
reveal themselves as clicks when you listen to the sound files. If you 
experience this problem, check the Overlap (safer but slower) 
option in the extraction progress window. When the Overlap option 
is checked, TAE verifies the data before saving it, to ensure accurate 
extraction.

After reading, the waveforms are displayed: 

Note: TAE stores the data for the waveform display in a 
folder called “TAE Waveform Cache ƒ” located in the same 
folder as the Toast Audio Extractor application. If you delete 
these files, the waveforms will have to be recreated the next 
time you use that particular disc.
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Operational Controls
This section of the main window contains the main controls. There 
are buttons for starting the Extraction process, setting sound 
options, and playing and previewing the selected audio tracks. 

Options
The Options button brings up this window which lets you specify 
the desired format for the extracted tracks:

Note: If you select Toast Image File as the sound format, 
TAE will save a single file containing all the items you’ve 
selected for extraction (Toast recognizes the individual tracks 
within the image file.) All other formats save one file for each 
track.

The selected format is indicated in the lower right corner of the main 
window too:

Extract
Clicking the Extract button begins extraction of any selected tracks. 
If no tracks are selected, the entire CD is extracted.

Specify your 
preferred 
sound file 
format here.
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Zoom Controls
This section of the main window contains the Zoom controls. They 
affect what you see in the Track Display area.

Extracting Tracks
To extract tracks from the CD, simply select the desired track or 
tracks and click the Extract button. TAE presents a standard file 
naming window; specify the name and location for the extracted 
files and click the Save button.

As a short-cut, you can simply select any track or tracks in the track 
list or track display and drag them to the desired location in the 
Finder. TAE immediately begins extracting the chosen items to that 
location.

❒

 Zoom In button will increase the 
magnification of the selected track(s)

Zoom Out button will decrease the 
magnification of the selected track(s)

 Show All button will show all the 
tracks in the Track Display area

Zoom to Selection button will zoom 
the selected track(s) to the full width 
of the Track Display area

This is very useful if you want to select 
just a portion of a track for extraction.
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Appendix
About CD-Rewritable Drives
CD-Rewritable is a new technology that allows a recordable CD to 
be erased and reused. To take advantage of this technology you need 
a CD-rewritable drive and special erasable media.

If you have a rewritable drive, you can erase your disc at any time 
by inserting the disc in your recorder, selecting the Disc Info 
command from the Recorder menu and clicking the Erase... button.

The Erase Confirmation dialog box gives you the option to perform 
a Quick Erase or a Standard Erase. Quick Erase erases only the TOC 
(Lead-in) and the pregap of the first track, which is very fast. This 
option is ideal for discs that will be written with Toast but is not 
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compatible with packet-writing. If you want to be able to write the disc 
with software other than Toast, be sure to select the standard Erase button.

■ Toast can erase in the background if SCSI 4.3 is present. Erasing 
can not be aborted. 

Toast ejects the disc after erasing without any further messages.
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Toast and AppleScript
Toast 3.5 is fully scriptable using AppleScript. Virtually any type of 
CD mastering tasks can be automated.

Note: It is beyond the scope of this manual to cover 
application scripting. However, there are many good books 
available on the subject.

Sample Scripts
When you ran the Toast installation program it installed several 
sample scripts on your hard drive. These will give you a glimpse 
into what’s possible with Toast and AppleScript.

Toast & Shutdown script

This simple script writes a CD and then shuts down the machine. 
This might come in handy if you’d like to start a CD writing session 
before you leave the office. The script assumes that Toast is running 
and ready to start writing (data selected, etc). In case of an error the 
script is aborted and the Mac is not shut down, so that you can 
examine the cause of the error when you return.

Copy SCSI Disk script

This is a sample script that demonstrates how you can setup Toast to 
copy the first 30 MB of the SCSI device at Bus 0, ID 0 (usually the 
internal hard disk) to CD. (You normally wouldn’t want to do that.)

Drop*Burn script

A somewhat more complicated script that writes items dropped 
onto it to CD. It demonstrates how AppleScript can be used to create 
a customized user interface for Toast.

Hybridizer script

This sample Droplet offers an easy way to set up a Mac/ISO hybrid 
disc. Just prepare a Mac volume as usual, and put all the ISO data in 
a folder on that volume. Then drop that folder onto the Hybridizer 
icon.
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For more information please open the AppleScript dictionary using 
ScriptEditor or other similar application.

NOTE FOR SOFTWARE DEVELOPERS:
Please contact us if you want to control Toast from your application 
via AppleEvents. A header file containing useful constants and 
some documentation is available on request.
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Troubleshooting
This table contains answers to commonly asked questions and 
problems relating to writing CDs. 

The questions are grouped as follows:

■ Sections for each of the different disc formats

■ Checking the Data Rate

■ Before Writing

■ While Writing

■ After Writing

Problem/Question Information Possible Solutions

Mac Volume format
Some windows do not look 
the same as on the original 
(that is, you closed all the 
windows, but when the CD 
is mounted, some windows 
are open).

The information about 
window positioning, size, 
and view is only recorded 
by the Finder from time to 
time. The latest position was 
still not saved by the Finder 
before the disc was written. 

Unmount the volume (drag 
it into the Trash) and mount 
it again before writing or 
open any application (the 
Finder will then save all 
window positions). 

Although a volume’s 
amount of used space does 
not exceed the capacity of a 
CD-R, you get the message 
that the data will not fit on 
the CD-R.

The selected volume is 
fragmented,that is, the data 
is not stored contiguously 
on the volume. Click Info… 
to see how the data is stored. 
The important value is the 
Size of CD-ROM. 

Defragment the volume 
using a commercial disk 
optimizer (for example, 
Norton Speed Disk™”) or 
Check the Optimize option 
in the Volume Selection 
window. 

Although you checked 
Optimize for Size the value 
for the amount of data to be 
written displayed in the 
main window seems to be 
too big.

The amount of data actually 
written is only displayed 
after Toast has performed its 
optimization procedure. 

Click Check Speed… on the 
main window. Before 
checking the data rate, 
optimization takes place. 
Afterwards the real value is 
displayed in the main 
window. 

You select a volume and get 
the following message: 
“Your Volume” could not 
be unmounted. All open 
files and programs on this 
volume must be closed first.

Volumes with open files or 
applications cannot be 
written without 
optimization. 

Close all files and quit open 
applications or check the 
option Optimize. This will 
allow you to write open files 
and programs. 
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You drag a volume onto the 
main window while the Mac 
Volume format is selected. 
Toast changes to another 
format and selects the data 
in this format.

Only local Macintosh HFS 
volumes can be written in 
Mac Volume format. 

Depending on the kind of 
volume Mac Files & Folders 
(when a server volume is 
dragged) or SCSI Copy 
(when no HFS volume is 
dragged) is selected. The 
data is then loaded 
automatically. 

You get the following 
message: The Apple CD-
ROM driver could not be 
found. Would you like to 
look for it?

You checked the Bootable 
option but no Apple CD-
ROM driver was found in 
the System Folder of your 
startup volume. (Toast uses 
the Apple CD driver to 
create the necessary boot 
information on a Bootable 
CD.) 

Click OK and select the 
driver which is to be used to 
boot from the disc. 

You wrote more than one 
HFS session on the same 
disc. When you insert the 
disc you only see the first 
session.

Your current CD-ROM 
driver does not support 
multisession discs. 

If you have an Apple CD-
ROM Drive, install the 
Apple CD-ROM driver 
version 5.1.x (or higher) or 
mount the disc using your 
CD writer and the system 
extension “Toast CD 
Reader”. NOTE: Each HFS 
session is mounted as an 
individual volume/icon. 

In older versions of Toast 
you could mount a 
temporary partition by 
double-clicking its image 
file. Now when you double-
click an image file it just 
opens Toast.

Since disc images can now 
be saved for all formats, it 
might not be desirable (or 
even possible) to 
automatically mount a disc 
image when double-
clicking it. 

After double-clicking a disc 
image in the Finder, Toast 
will open with that image 
automatically selected in the 
“Disc Image” format. You 
can then click on the Mount 
button to mount the image. 

Even though a partially 
used volume appears to be 
totally defragmented (when 
viewed in the Info… 
window), Toast still reports 
that the entire drive is used.

You may be using Norton 
FileSaver™. FileSaver places 
its invisible files on the very 
last block of the drive, 
which makes Toast believe 
that the entire drive is full. 

Before writing, deactivate 
FileSaver for the selected 
drive. FileSaver will then 
delete its hidden files and 
Toast will report the correct 
amount of space used. 

Mac Files & Folders format
When you drag files and 
folders onto the selection 
window you get the 
following messages: Please 
insert disk… At the File 
Server “The Server” 
registered as… Some aliases 
couldn’t be resolved:

The option Resolve aliases 
was checked. The selected 
data contains aliases which 
point to data which cannot 
be found. This often 
happens when you drag a 
System Folder containing 
folders like “Recently used 
applications” or similar. 

Uncheck the Resolve aliases 
checkbox. The aliases are 
loaded as aliases and are not 
resolved. (They are 
displayed in italics.) 

Problem/Question Information Possible Solutions
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You drag files and folders 
onto the selection window. 
You get the following 
message: Couldn’t 
complete the last command 
because the volume could 
not be found. 
Error code = -35.

The option Resolve aliases 
was checked. The selected 
data contains aliases which 
point to a volume which 
cannot be found. 

Connect the respective 
volume or Uncheck the 
option Resolve aliases. 
These aliases will then 
loaded as aliases and are not 
resolved. 

You insert a disc written in 
“Mac Files & Folders” 
format and the icons of files 
created by a specific 
application don’t look like 
they usually do.

The desktop files used for 
the disc do not contain 
information about the 
applications used to create 
those files. 

Before importing any data, 
import a folder from the 
volume which contains the 
respective applications. 
Then the desktop files from 
that volume will used (see 
“Mac Files & Folders 
Format” on page 6-8). 

You wrote more than one 
HFS session on the same 
disc. When you insert the 
disc you only see the first 
session.

Your current CD-ROM 
driver does not support 
multisession discs. 

If you have an Apple CD-
ROM Drive, install the 
Apple CD-ROM driver 
version 5.1.x (or higher) or 
mount the disc using your 
CD writer and the system 
extension “Toast CD 
Reader”. NOTE: Each HFS 
sessions is mounted as an 
individual volume.

ISO 9660 format
You want to back up your 
Macintosh data using ISO 
format. After importing the 
data, all names are 
shortened and the original 
names are displayed beside 
the new names in gray 
letters.

A naming option was 
chosen which doesn’t allow 
more than 8.3 characters. 

In the ISO window click 
Settings and choose Allow 
Macintosh Names.  Also 
check the option Use Apple 
Extensions. 

When you drag files and 
folders onto the selection 
window you get the 
following messages:  Please 
insert disk… At the File 
Server “The Server” 
registered as… Some aliases 
couldn’t be resolved:

The option Resolve aliases 
was checked. The selected 
data contains aliases which 
point to data which cannot 
be found. This often 
happens when you drag a 
System Folder containing 
folders like “Recently used 
applications” or similar. 

Uncheck the Resolve aliases 
checkbox. The aliases are 
loaded as aliases and are not 
resolved. (They are 
displayed in italics.) NOTE: 
Aliases only work on the 
Mac! 

You drag files and folders 
onto the selection window. 
You get the following 
message: Couldn’t 
complete the last command 
because the volume could 
not be found. 
Error code = -35.

The option Resolve aliases 
was checked. The selected 
data contains aliases which 
point to a volume which 
cannot be found. 

Connect the respective 
volume or Uncheck the 
option Resolve aliases. 
These aliases will then 
loaded as aliases and are not 
resolved. 

Problem/Question Information Possible Solutions
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After importing all the data 
you click Write CD…. The 
option Write Session is not 
available.

Either there is not enough 
free space on the disc to add 
another session or You 
didn’t choose CD-ROM XA 
for the format in the ISO 
dialog. 

If there is not enough free 
space on the disc the disc 
will have to be closed. Click 
Write Disc. Be sure to choose 
CD-ROM XA for the format 
in Settings. 

After importing all the data 
you click Check Speed… or 
Write CD… and get the 
following message: The ISO 
9660 standard does not 
allow more than 8 levels of 
nested folders. The disc will 
not conform to the ISO 9660 
standard if you continue.

The naming options were 
set to Allow MS-DOS 
Names or ISO 9660 Level 1. 
Your data contain more than 
8 levels of nested folders. 

If you write this disc some 
files may not be visible 
when reading the disc on a 
PC. (It depends on the 
particular ISO driver 
whether more than 8 
directory levels can be 
accessed.) 

You wrote an ISO 
multisession disc. If you 
read the disc on the 
Macintosh, each session is 
mounted as a separate 
volume, but all sessions 
have the same name and 
apparently the same 
contents. 

Some CD-ROM drivers are 
buggy. Instead of showing 
only the last session, all 
sessions are mounted. 

Install the lastest Apple CD 
drivers or read the disc with 
your writer and the 
extension “Toast CD 
Reader” or install other 
driver software, e.g. “CD-
ROM Toolkit™” from FWB. 

When you write a session to 
a disc which already 
contains an ISO session. You 
get the following message: 
The disc appears to be 
damaged. Ignore existing 
sessions? 

Important data could not be 
read from the disc such as 
the TOC (table of contents) 
or similar.  

If you continue, the session 
will be written as a separate 
volume.  

You wrote a multisession 
disc. When you insert the 
disc you only see the data of 
the last written session. Data 
from former sessions is not 
visible. 

When you wrote the last 
session you chose the option 
Ignore existing sessions or 
Incremental Backup. 

To recover the data of the 
previous session choose 
Import  Session in the ISO 
dialog. Import the previous 
session and add the data for 
the new session. 

You want to add a session to 
a disc which already 
contains at least one session. 
You click Write CD… and 
get the following message: 
“Your Session” is in CD-
ROM format. It is 
recommended to use CD-
ROM XA for multisession 
discs. Would you like to 
change the format to  CD-
ROM XA? 

You didn’t choose CD-ROM 
XA for the format options in 
the Settings window. 

Click Change. If not you will 
not be able to add any other 
data to this disc later. 

Problem/Question Information Possible Solutions
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You back up your data in 
ISO multisession format. 
The writing of the last 
session was aborted. You 
cannot read any file on the 
disc although you see them. 

The TOC was written but 
nothing else. 

You can recover the data of 
the previous session by 
using the Import Session 
command in the ISO dialog. 
Import the last session 
which was correctly written 
and add the data for the 
new session. 

You drag a volume onto the 
ISO selection window. Items 
which were on the desktop 
or in the trash on the 
volume are not shown in the 
list. 

There is neither a “Desktop 
folder” or a “Trash” folder 
on ISO discs so items in 
those directories cannot be 
written to an ISO disc. 

If you want to write those 
items, drag them onto the 
selection window after 
dragging the volume. 

You wrote a disc with 
Macintosh names. Some file 
names are not shown like 
they were originally 
defined.   Therefore you get 
error reports when 
comparing the disc with the 
original data (when using 
Compare from the Utilities 
menu). 

Some ISO drivers cut the 
following characters at the 
end of a file name: “blank”, 
“;”, “.”, “;number”. 

Press the Option key while 
inserting the disc in the Mac. 
Then all names are 
displayed in their full 
length. 

Mac/ISO Hybrid format
You have selected a volume 
for the Macintosh part. In 
order to share data with the 
ISO part you drag files from 
the same volume onto the 
ISO selection window. You 
get the following message: 
“Optimize for Speed” will 
be used, because the 
allocation block size of 
“Your Volume” is not a 
multiple of 2 K. 

You can only have shared 
data on Macintosh volumes 
with an allocation block 
size which is a multiple of 2 
K.  Otherwise the optimizer 
has to be used.  

If your computer is not fast 
enough to optimize on-the-
fly. 
Save all data as a disc image 
before writing -or- Use a 
temporary partition created 
with Toast for the Mac 
volume -or-  Reformat your 
hard disk with a correct 
block size. 

You do not have a complete 
volume available which 
only contains the Macintosh 
and the shared data. 

Choose the format Mac Files 
& Folders and drag all 
desired data onto the 
selection window. 
Save the data as a disc 
image. Mount the disc 
image and use it as the Mac 
data source -or- Create a 
temporary partition and 
copy all the data into the 
partition. 

Problem/Question Information Possible Solutions
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You want to have shared 
data on a Hybrid disc. You 
select all data for the 
Macintosh and the ISO part 
but no data is recognized to 
be shared. 

In order to share data, they 
have to be placed on the 
selected Macintosh volume 
and they have to be selected 
again for the ISO part. 

Make sure that you import 
the data from the already  
selected Macintosh volume 
in the ISO dialog.  If the 
shared data was defined 
using aliases, make sure that 
the aliases point to items  
placed on the selected Mac 
volume and that the option 
Resolve aliases is checked. 

You wrote several Hybrid 
sessions onto the same disc. 
You get different results 
when reading the disc on a 
Macintosh or on a PC.  

Hybrid discs should never 
be written as multisession 
discs. 

On a PC you will only see 
the last written session, on a 
Macintosh you will either 
see only the first session or 
all sessions as single 
volumes (depending on the 
installed driver) 

You wrote a Hybrid track as 
the second session of an 
audio CD. When you insert 
the disc into your CD-ROM 
drive you cannot see any 
data, only audio tracks are 
displayed. 

Older CD-ROM drivers do 
not read such discs correctly. 

Install another CD-ROM 
driver: Apple CD-ROM 
driver version 5.1.x or 
higher, “CD-ROM 
Toolkit™” or use your 
writer with the extension 
“Toast CD Reader”. 

Audio CD/ Audio Tracks format
You drag an audio file onto 
the audio selection window 
and get the following 
message: Only 16 bit/44 
kHz sound can be written. 
“Your File” is not in this 
format. 

The audio file has the wrong 
format. 

Save sound files in the 
following format: 16 Bit, 
44.1 kHz, stereo or mono. 

Beside the name of the file 
“Mono” is displayed in 
brackets. 

The sound file was saved in 
mono format. 

Mono files are converted 
into stereo files where both 
channels contain exactly the 
same sound information. 

You take an audio CD to a 
disc replicator for 
duplication and they report 
a problem with the master. 

Toast writes audio CDs 
using “track-at-once” 
mode, but replicators prefer 
auido master discs written 
in “disc-at-once” mode. 

Use a program like Toast 
CD-DA to write your audio 
master. 

You hear noises between 
audio tracks although your 
original data is correct. 

The firmware versions of 
some writers cause clicks 
between tracks. 

Please contact your 
hardware dealer to get a 
firmware update for your 
writer. 

Before writing you get the 
following message: Your 
recorder does not support 
index generation. All index 
markers will be ignored. 

Not all writers can write 
index-points in track-at-
once mode. 

If you need to have index-
points on the disc (they are 
very seldom used) use 
another application which 
writes in disc-at-once mode, 
e.g. “Toast CD-DA”. 

Problem/Question Information Possible Solutions
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CD-i format
You drag a disc image onto 
the main window. Toast 
changes to “Video CD” or 
“Disc Image” format. 

Only images conforming to 
the “green book” standard 
can be written as CD-i. 

CD-i images can only be 
created with special 
authoring software as the 
structure defined in the 
“green book” is very 
specific. 

You selected a disc image 
after clicking Data… in the 
CD-i format. You write the 
disc but it cannot be read by 
CD-i players. 

The disc image might have 
had the wrong format. 

Drag the image onto the 
main window. If it is not a 
CD-i image Toast will 
change to the appropriate 
format. “

Video CD format
You import an MPEG 
stream and get the following 
message: “Your File” can not 
be used to create a Video 
CD. Please use the “Toast 
Ready” option in ASTARTE 
M. Pack. 

The file does not contain the 
required information to 
create a Video CD. 

Multiplexing has to be 
performed with the 
software “ASTARTE M. 
Pack” (version 1.02 or 
above). The option Toast 
Ready has to be checked. 

When a Video CD is created 
from individual MPEG 
streams, what functionality 
will be available on the 
finished disc? 

There will be one menu 
which allows you to play 
the videos, stop, fast 
forward, rewind, pause, go 
to next video track, and go 
to previous video track. 

You drag an image file onto 
the main window while the 
“Video CD” format is 
selected. Toast changes to 
the “Disc Image” format. 

Your file is not a valid Video 
CD disc image. 

Use a Video CD authoring 
system to create a Video CD 
disc image or import MPEG 
streams created with 
“ASTARTE M. Pack”. 

Enhanced Music CD format
You select a volume in 
“Enhanced Music CD” 
format and get the following 
message: “Your Volume” 
does not contain a CD 
EXTRA directory hierarchy 
or a QuAC file. It can not be 
used to create an Enhanced 
Music CD. 

The structure of a CD 
EXTRA is very restrictive 
(defined in the “blue book”). 
Your volume does not 
contain such a structure nor 
does it contain a valid 
QuAC file. 

Create a QuAC file with the 
software “Apple Interactive 
Music Toolkit™”. Create a 
CD EXTRA hierarchy. 
Currently there is no 
authoring system which 
creates such a structure for 
you. Experienced 
programmers which have 
the “blue book” 
specifications can create the 
CD EXTRA structure 
manually. 

You wrote an “Enhanced 
Music CD” track as second 
session of an audio CD. 
When you insert the disc in 
your computer you can only 
see the audio tracks, no 
data. 

Older CD-ROM drivers do 
not read such discs correctly. 

Install another CD-ROM 
driver: Apple CD-ROM 
driver version 5.1.x or 
above, “CD-ROM Toolkit™” 
or use your writer with the 
extension “Toast CD 
Reader”. 
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A-11



Toast User’s Guide
You put extra data into the 
folder “CD EXTRA” in 
order to make them visible 
on the PC. All file and folder 
names are cut. 

Toast uses the naming 
convention “Allow MS-
DOS names” for the ISO 
part of a CD EXTRA (see 
“ISO 9660 Format” on page 
6-15). 

If don’t want Toast to 
transform the names for 
you, make sure that all 
names in the folder “CD 
EXTRA” have a length of 8.3 
characters. 

You get the following 
message before writing: The 
audio tracks will be written 
into the second session. 
Most likely this is not what 
you want. 

In order to play the audio 
tracks on a CD player the 
tracks have to be placed in 
the first session of a disc.  

For the first session of an 
Enhanced Music CD only 
select audio files in the 
Audio CD format. Then add 
the data as a second session 
on the same disc.

SCSI Copy format
You copied a SCSI hard 
drive. The disc is not 
readable when inserted into 
a CD-ROM drive. 

Almost no operating 
system (except the Mac OS) 
is able to read CD-ROMs 
which have the same file 
system as a hard drive. If 
you try to copy an MS-DOS 
formatted hard drive 
directly, you will not be able 
to read this disc, since DOS 
expects a read-only file 
system for CDs. 

Mount the respective hard 
drive on the Macintosh and 
write the data in the “ISO 
9660” format rather than 
using SCSI Copy. 

You want to copy a disc 
directly. While checking the 
data rate or while writing 
you get an error message. 

Not all CDs can be copied 
directly. CDs containing 
mode 2 form 2 cannot be 
copied. These are: Video 
CDs, CD-is, CD EXTRAs, 
Photo CDs, etc.. 

Use another application to 
extract the tracks of these 
discs so that they can be 
written back onto disc, for 
example, ASTARTE CD-
Copy. 

You copy a bootable CD but 
the copy is not bootable. 

The wrong options were set 
in the SCSI Copy dialog. 

Click Options… and 
UNCHECK the option 
“Clear Driver Descriptor 
Map” before copying the 
disc. 

Disc Image format
You want to mount a disc 
image and get the following 
message: “Your File” is 
fragmented. Please use a 
commercial Disk Optimizer 
to defragment the volume 
“Your Volume”. You can 
also try to duplicate the file 
or copy it to another 
volume. 

Only defragmented disc 
images can be mounted. 

Defragment the volume 
which contains the disc 
image (e.g. with “Norton 
Speed Disk ™”).   In some 
cases it might help to 
duplicate the image or to 
copy it to another volume. 

Problem/Question Information Possible Solutions
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You want to mount a disc 
image and get the following 
message: “Your File” could 
not be mounted because it 
contains an unknown file 
system. Most likely the 
system extensions files 
“Foreign File Access” 
and/or “ISO 9660 File 
Access” are not installed. 

These files must be installed 
in your system folder in 
order to mount a disc image 
which is not in Macintosh 
HFS format. 

Did you boot your Mac with 
all extensions OFF? Verify 
that the extensions folder in 
your system folder contains 
the files “Foreign File 
Access” and “ISO 9660 File 
Access”. Restart your Mac 
with extensions ON. 

You want to save a disc 
image and get the following 
message: The image file 
could not be created because 
the disk is full: x MB are 
needed, y MB are available. 

The selected volume does 
not have enough free space 
to save the image. 

Select another volume to 
save the image. 

Multitrack CD-ROM XA format
You add a file and get the 
following message Warning: 
The length of “Your File” is 
not a multiple of the sector 
size.

The file is not a valid CD-
ROM XA file as it has an 
invalid length.

You can write this file to 
disc, but it might not be 
usable.

Checking the Data Rate
You get the following 
message: A RAM Cache of x 
MB was requested but only 
y MB could be allocated. To 
make more memory 
available, try quitting other 
running applications (if 
any.) 

A higher RAM cache than 
available RAM was defined 
in Preferences (menu Edit). 

If you don’t change 
anything, Toast uses the 
maximum available RAM 
for the RAM cache. Quit 
other applications to get 
more available RAM. 

You get the following 
message: Couldn’t 
complete the last command 
because of a Mac OS error. 
Error code = 2. 

The selected data cannot be 
read by a Macintosh. This 
happens e.g. when you try 
to copy a disc which 
contains mode 2 form 2 or 
audio sectors. 

Extract the tracks of the disc 
with appropriate software, 
e.g. “ASTARTE CD-Copy”. 

For information on other 
problems related to 
checking the data rate see 
“What to do if “Check 
Speed” fails” on page 7-4.

Before Writing
You get the following 
message: An unknown 
driver is installed for SCSI 
ID x. If you run into 
problems, please remember 
to disable the driver next 
time. 

Some drivers cause 
problems during writing. 
These could be other CD-
writer drivers, scanner 
drivers, etc.. 

you are running System 
7.5.x, boot with all 
extensions off (shift-boot). 
With other System versions, 
disable all extensions which 
are not needed to write. 
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You get the following 
message: This recorder can 
not write a CD-ROM track 
on a CD-ROM XA, sorry. 

Some writers do not allow 
mixing formats on a disc. 
The inserted disc contains at 
least one CD-ROM XA 
track. 

If Select the data in “ISO 
9660” or “Mac/ISO Hybrid” 
format and choose CD-ROM 
XA for the format settings. 

You get the following 
message: This recorder can 
not write a CD-ROM XA 
track on a CD-ROM, sorry. 

Some writers do not allow 
mixing formats on a disc. 
The inserted disc contains at 
least one CD-ROM track. 

Select the data in “Mac Files 
& Folders” or “Mac 
Volume” format.  If you 
wish to use the “ISO 9660” 
or “Mac/ISO Hybrid” 
format, choose CD-ROM 
for the format settings. The 
disc is closed after this 
session (Write Session is not 
available). 

You click Write Disc or Write  
Session and get the 
following message: Failed to 
allocate x MB of temporary 
hard disk cache on “Your 
Volume”. Please use the 
“Preferences” menu item to 
select a different volume. 

The selected data contains 
many small files which have 
to be saved to the temporary 
hard disk cache in order to 
avoid speed problems 
while writing. The selected 
hard disk does not have 
enough free space to save all 
the required files. 

Choose Preferences from the 
Edit menu and select 
another hard drive which 
contains more free space 
than the currently selected. 
Or create a disc image of the 
selected data (then no 
temporary hard disk cache 
is needed).  

The option Write Session is 
not available in the write 
dialog. 

You have selected more than 
625 MB of data to write. 
There is not enough free 
space on the disc to write 
more sessions after the  
current one. You chose “ISO 
9660” or “Mac/ISO Hybrid” 
format and you did not 
choose the option CD-ROM 
XA for the format settings. 

There wouldn’t be enough 
space for another session, 
so Toast disables that 
option. Use a blank CD-R. 
Choose CD-ROM XA for the 
format settings in the ISO 
dialog Settings. 

You get the following 
message: You can not write 
this disc with the selected 
recorder. 

Not all writers can write all 
disc formats. 

This message mostly 
appears when writing the 
following formats with 
some writers: Video CD, 
CD-i, Multitrack CD-ROM 
XA, Enhanced Music CD. 
Please contact your dealer. 
There might be a firmware 
update for your writer 
which enables it to write 
these kinds of discs. 

While Writing
You get the following 
message: SCSI Error:  The 
SCSI connection is not 
stable. Please check the 
cables and termination. 

This message only appears 
with unstable SCSI 
connections. Cables, 
terminators or SCSI ports 
might be damaged. 

Check cables and 
termination. The problems 
might not be apparent in 
normal disk operations, but 
writing a disc requires 
perfect SCSI connections! 
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❒

You get the following 
message: The drive reported 
an error:: Sense Key = …  
Sense Code = 0x… 
Description 

These messages are sent 
from the writer and are 
different for each 
brand/model of writer. 

If you get an error which is 
not explained in this section 
please write down the Sense 
Code and the Description 
before requesting technical 
support. This will be a big 
help in resolving the 
problem. 

Description =  BUFFER 
UNDERRUN 

The writer’s data buffer ran 
out while writing. If this 
happens the write 
procedure will be aborted 
and the disc will be 
unusable. 

Disable all system 
extensions which are not 
needed. Remove all drives 
from the SCSI chain which 
are not needed. Check 
cables and terminator. 
Replace them if necessary. 
Choose a lower write speed. 
Increase the RAM cache in 
Preferences from the Edit 
menu. 

Description =  TRACK 
FOLLOWING ERROR 

This is a calibration 
problem. The write laser is 
not able to find the last bit of 
data on the disc. 

Your recorder is not level. 
The inserted CD-R is 
damaged. The brand of 
media is not compatible 
with your writer. The 
writer’s calibration 
mechanism is defective. 

Sense Key =  HARDWARE 
ERROR 

These errors are mostly 
generated by the writer’s 
hardware. The writer might 
be damaged. 

If errors of this kind occur 
frequently please contact 
our technical support. 

Sense Key =  MEDIUM 
ERROR 

Most of these errors occur 
because of problems with 
the particular brand or batch 
of CD-Rs you are using. 

Change the brand of CD-Rs. 
There are big differences in 
quality. 

After Writing
While verifying you get the 
following message: 
Mismatch at byte x/sector y. 
Verification failed. 

While comparing the disc 
with the original data a 
mismatch was found. 

Verify the disc by choosing 
the Compare command 
(Utilities menu). 

The Verify button is not 
available. 

You probably selected one of 
these formats: Audio CD, 
Video CD, CD-i, Enhanced 
Music CD, Multitrack CD-
ROM XA. 

Only discs that are readable 
by the Mac can be verified.  

Problem/Question Information Possible Solutions
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